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Chapter 1 Introduction
Bio-Rad’s high-performance PCR amplification systems feature the latest technological advances,
providing greater accuracy and reproducibility in nucleic acid amplification for genomic
experiments.

Using CFX Maestro™ software for Mac (known in this guide as CFX Maestro software for Mac) you
can interpret complex data and craft powerful studies for genetic analysis. With just a few clicks,
you can set up studies and make sense of your gene expression study with tools such as t-tests,
one-way ANOVA, PrimePCR™ controls analysis, and the reference gene selector tool. Then, you
can prepare your results for publications and posters with CFX Maestro’s highly customizable data
visualization and annotation tools.
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Chapter 1 Introduction

Main Features of CFX Maestro Software for Mac
With CFX Maestro software for Mac you can do the following:

n Analyze data using bar charts, clustergrams, scatter plots, heat maps, or volcano plots to
quickly interpret and understand your results.

n Customize your data representation and export high resolution graphs for publication and
report generation.

n Determine RNA quality and troubleshoot experiments with PrimePCR analysis controls.

n Select the appropriate reference gene and analyze its stability with the Reference Gene
selection tool.

n Perform statistical analysis including one-way ANOVA in gene expression analysis.

This user guide explains these features and how to use them.

Finding Out More
After installing CFX Maestro software for Mac, you can access this guide from the Help menu in
any view.

Tip: Click the Bio-Rad logo in the upper right corner of any CFX Maestro software for Mac
window to launch Bio-Rad’s website. This site includes links to technical notes, manuals,
videos, product information, and technical support. This site also provides many technical
resources on a wide variety of methods and applications related to PCR, real-time PCR, and
gene expression.

10 | CFXMaestro Software for Mac



Chapter 2 Installing CFX Maestro Software for
Mac

This chapter explains how to install CFX Maestro™ software. For information about setting up Bio-
Rad's supported real-time PCR instruments, see the appropriate guide.

CFX Maestro is required to analyze real-time PCR data from the CFX96 Touch™, CFX96 Touch
Deep Well, CFX Connect™, or CFX384 Touch™ systems.

System Requirements
Table 1 lists the minimum and recommended system requirements for the computer running CFX
Maestro software for Mac.

System Minimum Recommended

Operating system OS X El Capitan v10.11.4 OS X High Sierra v10.13.2

Ports 1 USB 2.0 High-speed port 1 USB 2.0 High-speed port

Hard disk space 128 GB 128 GB

Processor speed 2.4 GHz, Dual Core 2.4 GHz, Quad Core

RAM 4 GB RAM 8 GB RAM

Screen resolution 1024 x 768 with true-color mode 1280 x 1024 with true-color mode

PDF reader Adobe PDF Reader or a PDF Reader
from one of the supported Microsoft
Office for Mac Suites:

n 2007

n 2010

n 2013

Table 1. Computer requirements to run CFX Maestro software for Mac
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Chapter 2 Installing CFXMaestro Software for Mac

Installing CFX Maestro Software for Mac
Note: During the installation process, you will be prompted to register your software with
Bio-Rad Laboratories. If your CFX Maestro computer cannot access the registration server,
you can register the software by logging in to bio-rad.com/cfx-registration.

To install CFX Maestro

1. Log in to the CFX Maestro computer with administrative privileges.

2. Insert the CFX Maestro USB drive into the computer’s USB port.

3. Using the Finder, navigate to and open the CFX Maestro software for Mac USB icon in
Devices.

The USB drive contains the Release Notes file and the CFX Maestro software for Mac
installation package (CFXMaestroSetup1.1.pkg).

4. Double-click CFXMaestroSetup1.1.pkg to start the CFX Maestro installer.

5. Follow the on-screen installation instructions.

Tip: The installer also installs this guide, which is available from the Help menu in any
view.

6. When prompted, enter your username and password.

7. In the Registration dialog box, enter the required information and click Register.

Note: All fields are required.

If your computer cannot access the registration server, click bio-rad.com/cfx-registration in the
dialog box that appears to register CFX Maestro using your web browser. Click OK to close the
dialog box and continue installing the software.

8. When the installation completes, you can safely eject the USB drive and start CFX Maestro
software for Mac.

12 | CFXMaestro Software for Mac
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Software Files

Software Files
Table 2 lists the CFX Maestro software for Mac file types.

File Type Extension Details

Plate .pltd Contains plate setup details to perform a PCR run

Data .pcrd Contains the results of an experiment run and PCR
analysis

PrimePCR™ run .csv Contains protocol and plate layout for PrimePCR plates

Gene study .mgxd Contains results of multiple PCR runs and gene
expression analyses

Stand-alone pre-data file .zpcr Contains fluorescence readings from stand-alone
operation that are converted into a data file

LIMS .plrn Contains plate setup and protocol information required
to conduct a LIMS compatible run

Table 2. File types in CFX Maestro software for Mac
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Chapter 3 The Workspace
CFX Maestro™ for Mac provides an interface for setting up PCR plates and analyzing data from
real-time PCR runs.

CFX Maestro software for Mac presents three primary workspaces:

n The Home window

n The Data Analysis window

n The Plate Editor window

These workspaces are shown and briefly described in this chapter.
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Chapter 3 TheWorkspace

The Home Window
CFX Maestro software for Mac opens to the Home window, from which you can open existing
plates or data files or create a new plate or gene study file. From the Home window you can also
view application and instrument logs and access useful tools. For more information, see Chapter 4,
The Home Window.
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TheData AnalysisWindow

The Data Analysis Window
In the Data Analysis window you can view and compare run data, perform statistical analyses,
export data, and create publication-ready reports. Data Analysis functionality is detailed in Chapter
5, Data Analysis Overview. See also Chapter 6, Data Analysis Details.
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Chapter 3 TheWorkspace

The Plate Editor Window
In the Plate Editor window you can create, open, review, and edit a plate. Plate Editor functionality
is detailed in Chapter 8, Preparing Plates.
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Chapter 4 The HomeWindow
CFX Maestro™ software provides an interface for analyzing PCR run data. It also provides an
interface for creating PCR plate files and gene studies.

This chapter introduces CFX Maestro software for Mac and describes the features accessible from
the Home window.

The Home Window
CFX Maestro software for Mac opens to the Home window, from which you can analyze an existing
run or set up a new plate file or gene study. From the Home window you can also set user
preferences and view the application log.
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Chapter 4 The HomeWindow

The main pane provides quick access to data analysis, plate, gene study, and PrimePCR™ files.
This pane also displays links to the ten most recently opened files. The right pane displays
commands to create a new plate file or gene study. The date and time appear in the status bar at
the bottom of the window.

Tip: Click the Bio-Rad logo in the upper right corner of any CFX Maestro software for Mac
window to launch the Bio-Rad website. Check the website often for updates to CFX Maestro
software for Mac and documentation.

File Menu Commands
New— opens a dialog box from which you can choose to create a new plate or gene study.

Open— opens a dialog box from which you can choose to navigate to and open an existing
protocol, plate, data file, gene study, run from a stand-alone instrument (stand-alone run), or
PrimePCR run file.

Exit— closes CFX Maestro software for Mac.

View Menu Commands
Application Log— displays a usage log for CFX Maestro software for Mac from initial installation
to the current day.

User Menu Commands
User Preferences— opens the User Preferences dialog box, in which users can change the
default settings for

n Saving data files

n Create plates

n Analyzing data

n Performing gene expression analysis

n Exporting CFX data
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Help Menu Commands
Tip: The Help menu is available on the menu bar in all CFX Maestro software windows.

Contents— displays the Contents tab in the CFX Maestro Help system.

Index— displays the Contents tab in the CFX Maestro Help system.

Search— displays the Contents tab in the CFX Maestro Help system.

Open User Guide— opens a PDF of this guide.

Video Resources— opens a web site where video resources, such as instructional videos, reside.

qPCR Applications and Technologies Web Site— opens Bio-Rad’s qPCR Applications &
Technologies web site, from which you can learn more about real-time PCR (qPCR).

qPCR Reagents Web Site— opens Bio-Rad’s PCR and qPCR reagents web site, from which you
can order PCR reagents, supermixes, dyes, and kits.

qPCR Plastic Consumables Web Site— opens Bio-Rad’s PCR Plastics and Consumables web
site, from which you can order PCR plates, plate seals, tubes and caps, and other plastics
accessories.

Software Web Site— opens Bio-Rad’s PCR Analysis Software web site, from which you can order
updated versions of Bio-Rad’s CFX Maestro software.

About— displays CFX Maestro copyright and version information.
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Chapter 4 The HomeWindow

Before You Begin
Tip: It is not required to perform these tasks in order to use CFX Maestro software for Mac. You
can safely skip this section or perform these tasks at any time.

Performing Software Updates
Bio-Rad provides access to updates to CFX Maestro on its web site. To determine whether
updates are available, select CFX Maestro > Check For Updates on the Mac Home window.

When updates are available, the Software Update dialog box automatically appears.

Important: Close all data analysis windows before beginning the update. When the software
update completes, CFX Maestro software for Mac automatically restarts.

To perform software updates

u In the Software Update dialog box, click Install Update.

To display the Update dialog box

u On the Mac Home window, select CFX Maestro > Check For Updates.
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Before You Begin

Setting User Preferences
Tip: It is not required to perform these tasks in order to use CFX Maestro software for Mac. You
can safely skip this section or perform these tasks at any time.

In CFX Maestro software for Mac you can customize the working environment. For example, in the
Users > User Preferences menu, you can do the following:

n Change the default location in which to save files.

n Set the default parameters to use when creating a new plate.

n Set the default data analysis and gene expression parameters.

n Customize data export data parameters.

This section explains how to perform these tasks in detail.

Changing the Default File Settings

In the Files tab on the User Preference dialog box, you can change the following:

n The default location in which to save CFX Maestro files

n The default files for run setup

n The default file naming parameters

To change the default file settings

1. Select Users > User Preferences to open the User Preferences dialog box.

2. In the User Preferences dialog box, select the Files tab.
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Chapter 4 The HomeWindow

3. In the Default Folder for File Creation section, navigate to and select a default folder in which
you want to save new files. You can select a different location for each file type:

n Protocol

n Plate

n Data File

n Gene Study

4. In the File Selection for Run Setup section, navigate to and select the target protocol and plate
files to appear when you open the Experiment Setup window.

5. In the Data File section, define the prefix and/or suffix for data files. For any part, select a new
value from its dropdown list. You can also provide custom prefix and suffix values in the Prefix
and Suffix text boxes.

CFX Maestro displays a preview of the file name below the selection boxes.

6. Click OK to save the changes and close the dialog box.

Important: Clicking Restore Defaults in the User Preferences dialog box resets all
preferences on all tabs to the original factory settings. Take care when clicking this button.

Setting Default Plate Parameters

Changes that you make to the Plate tab are available to all users of the software. Changes that you
make during plate setup are available to users after you save and close the plate file.

In the User Preferences dialog box you can do the following:

n Set default plate parameters.

n Add new target, sample, and biological group names to their respective libraries.

n Delete target, sample, and biological group names from their respective libraries.

To set the default plate parameters

1. Select Users > User Preferences to open the User Preferences dialog box.

2. In the User Preferences dialog box, select the Plate tab.
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Before You Begin

3. Specify values for the followings settings for a new plate file. These values appear in the Plate
Editor window:

n Plate type

n Plate size

n Units— the concentration of the starting template for wells that contain standards.

CFX Maestro uses these units to create a standard curve in the Data Analysis
Quantification tab.

n Scientific notation—when selected, CFX Maestro displays the concentration units in
scientific notation.

n Scan mode— the number or type of channels to scan during a run.

n Fluorophores— the default fluorophores that appear in the Plate Editor well loading
controls.

n Libraries— the targets, samples, and biological groups that you typically use in your
experiments:

o Target names— the names of target genes and sequences.

o Sample names— the names of experiment samples or an identifying characteristic
for the samples (for example, Mouse1, Mouse2, Mouse3).

o Biological group names— the names for groups of similar samples that have the
same treatment status or conditions (for example, 0Hr, 1Hr, 2Hr).
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Chapter 4 The HomeWindow

4. Click OK to save the changes and close the dialog box.

To add a new target, sample, or biological group name

u In the appropriate library box, type the name for the target, sample, or biological group and
click OK.

To delete a target, sample, or biological group name

u In the appropriate library box, select the name and press the Delete key and then click OK.

Important: Names that you remove from the library are removed from the software and are no
longer available to users. To restore the default CFX Maestro names, click Restore Defaults.
Clicking Restore Defaults in the User Preferences dialog box resets all preferences on all tabs
to the original factory settings. Take care when deleting default CFX Maestro names and when
clicking this button.
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Before You Begin

Setting Default Data Analysis Parameters

To set default Data Analysis parameters

1. Select Users > User Preferences to open the User Preferences dialog box.

2. In the User Preferences dialog box, select the Data Analysis tab.

3. In the Analysis Mode section, select the mode in which to analyze the data (either Fluorophore
or Target).

4. In the PCR Quantitation section, set default parameters for the following options:

n Baseline Setting— the baseline method for analysis mode.

n Cq Determination Mode— the mode in which Cq values are calculated for each
fluorescence trace (either regression or single threshold).

n Threshold Calc. Mode— the end-point target amount.

The default is Auto. That is, the software automatically calculates the end-point target. To
set a specific threshold, clear the Auto checkbox and enter your end-point amount,
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Chapter 4 The HomeWindow

calculated in relative fluorescence units (or RFU). The maximum value is 65000.00 RFUs.
Data files for subsequent runs will use this threshold setting.

n Baseline Calc. Mode— the baseline value for all traces.

The default is Auto. That is, the software automatically calculates the baseline for all
traces. To set a specific baseline value, clear the Auto checkbox and enter minimum and
maximum values for the cycle range (1 to 9999). Data files for subsequent runs will use
this cycle range.

n Log View— determines how the software displays the amplification data:

o On— the amplification data are displayed in a semilogarithmic graph.

o Off— (the default) the amplification data are displayed in a linear graph.

5. In the End Point section, select the number of end cycles to average when calculating the end-
point calculations:

n PCR run— the number of end cycles to average for quantification data (default is 5).

n End Point Only run— the number of end cycles to average for end-point data (default is
2).

6. In the Melt Curve section, select the peak type to detect (either positive or negative).

7. In the Well Selector section, select how to display well labels (by sample type, target name, or
sample name).

8. Click OK to save the changes and close the dialog box.

Important: Clicking Restore Defaults in the User Preferences dialog box resets all
preferences on all tabs to the original factory settings. Take care when clicking this button.
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Before You Begin

Setting Default Gene Expression Data File Parameters

To set the default parameters for a new gene expression data file

1. Select Users > User Preferences to open the User Preferences dialog box.

2. In the User Preferences dialog box, select the Gene Expression tab.

3. Specify the values for the following settings:

n Relative to— graphs the gene expression data relative either to a control (originating at
1) or to zero:

o Zero— the software ignores the control. This is the default when no control sample is
assigned in the Experiment Settings window.

o Control— the software calculates the data relative to the control sample assigned in
the Experiment Setup window.

n X-axis— graphs the sample or the target on the x-axis.

n Y-axis— graphs linear, log2, or log10 scale on the y-axis.

n Scaling— the scaling option for the graph (the default option is unscaled):

o Highest— the software scales the graph to the highest data point.

o Lowest— the software scales the graph to the lowest data point.
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o Unscaled— the software presents the data unscaled in the graph.

n Mode— the analysis mode, either relative quantity (∆Cq) or normalized expression
(∆∆Cq).

n Error Bar— the data variability presented as either the standard deviation (Std. Dev.) or
the standard error of the mean (Std. Error Mean).

n Error Bar Multiplier— the standard deviation multiplier used to graph the error bars
(default is 1).

You can increase the multiplier to either 2 or 3.

n Sample Types to Exclude— the sample types to exclude from the analysis.

You can select one or more sample to exclude from the analysis. To exclude all sample
types, clear the checkboxes of any selected sample types.

4. Click OK to save the changes and close the dialog box.

Important: Clicking Restore Defaults in the User Preferences dialog box resets all
preferences on all tabs to the original factory settings. Take care when clicking this button.

Customizing Data Export Parameters

You can export CFX Maestro data in the following formats:

n Text (.txt)

n CSV (.csv)

n Excel 2007 (.xlsx)

n Excel 2003 (.xls)

n XML (.xml)

n HTML (.html)

You can specify the type of data to export and customize the output of the exported data.

To customize data export parameters

1. Select Users > User Preferences to open the User Preferences dialog box.

2. In the User Preferences dialog box, select the Custom Export tab.
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3. On the Export Format dropdown list, select a format in which to export the data.

4. In the Data to Export section, select or clear the checkboxes for the type of data to export. The
selected items appear in the Exported Columns list box.

Note: By default, the run information is included in the header. Clear this checkbox if you
do not want the run information included.

5. You can change the output display order of the selected items.

In the Exported Columns list box, highlight the item and then click the arrow buttons to the left
of the list to move it up or down.

6. Optionally, you can change the output column names of the selected items:

a. Click Customize Column Names.

The Column Name Customizer dialog box appears.

b. For each default column name that you want to change, type the new name in its Custom
Name field.

c. Do one of the following:
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n Click OK to save the changes and return to the Custom Export tab. The new name
appears in parentheses beside the default column name in the Exported Columns list
box.

n Click Cancel to clear the changes and return to the Custom Export tab.

7. Click OK to save the changes and close the dialog box.

Important: Clicking Restore Defaults in the User Preferences dialog box resets all
preferences on all tabs to the original factory settings. Take care when clicking this button.
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Chapter 5 Data Analysis Overview
CFX Maestro™ software for Mac offers several methods to open and view data files. You can:

n Select File > Open in the Home window and browse to the target .pcrd file.

n Click the appropriate command in the Home window to open the Finder and navigate to the
target .pcrd file.

n Select a file from the Recent list in the Home window.

Data Analysis Window
The Data Analysis window displays multiple tabs, each tab showing the analyzed data for a
specific analysis method or run-specific information. Tabs appear only if the data collected in the
run are available for that type of analysis.

Tip: To choose the tabs to display, select them from the dropdown menu View in the Data
Analysis window. To return to the original tab layout, select Settings > Restore Default Window
Layout.
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Data Analysis Toolbar
The toolbar in the Data Analysis window provides quick access to important data analysis
functions.

Table 3 lists the functions of buttons in the toolbar.

Button Name Function

Plate Setup View/Edit plate: Opens the Plate Editor to view
and edit the contents of the wells.

Replace Plate file: Selects a plate file to replace
the plate layout.

Apply PrimePCR file: Selects a run file to replace
the plate layout for a PrimePCR™ run.

Manage Well
Groups

Opens the Well Groups Manager window to
create, edit, and delete well groups.

Well Group Selects an existing well group name from the
dropdown menu. The default selection is All
Wells. This button appears only when well groups
are created.

Analysis Mode Analyzes the data in either Fluorophore or Target
mode.

Help Opens the software Help for more information
about data analysis.

Table 3. Toolbar in the Data Analysis window
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Data Analysis Menu Bar
Table 4 lists the menu bar items in the Data Analysis window.

Menu Item Command Function

File Save Saves the file.

Save As Saves the file with a new name.

Close Closes the Data Analysis window.

View Run Log Opens a Run Log window to view the run log
of the current data file.

Quantification, Melt Curve, Gene
Expression, End Point, Custom
Data View, QC, Run Information

Displays the analyzed data in selected tabs
in the Data Analysis window. At least one tab
must be selected.

Table 4. Data Analysis windowmenu bar items
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Menu Item Command Function

Settings Cq Determination Mode Select Regression or Single Threshold mode
to determine how Cq values are calculated
for each trace.

Baseline Setting Select Baseline Subtraction method for the
selected well groups.

Analysis Mode Select to analyze data by Fluorophore or by
Target.

Cycles to Analyze Select the cycles that are to be analyzed.

Baseline Thresholds Opens the Baseline Thresholds window to
adjust the baseline or the threshold.

Trace Styles Opens the Trace Styles window.

Plate Setup Opens the Plate Editor to view and edit the
plate; replace the current plate with one from
a user-defined plate file or a PrimePCR run
file.

Include All Excluded Wells Includes all excluded wells in the analysis.

Mouse Highlighting Turns on or off the simultaneous highlighting
of data with the mouse pointer.

Tip: If Mouse Highlighting is turned off,
press the Control key to temporarily turn
on highlighting.

Restore Default Window Layout Restores the arrangement of windows to the
default setting.

Table 4. Data Analysis windowmenu bar items, continued
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Menu Item Command Function

Export Export All Data Sheets to Excel Exports all the spreadsheet views from every
tab to a separate Excel file.

Export RDML File Select a version of RDML (1.1 or 1.0) to open
a Save As window to specify an RDML file
name and location.

Custom Export Opens the Custom Export window in which
the fields to be exported and the file format
can be specified.

Export to LIMS Folder Opens a window to save data in a
predetermined format to the LIMS folder.

Tools Reports Opens the Report for this data file.

Well Group Reports Opens the Well Group Report window to
generate reports for specified well groups.

Import Fluorophore Calibration Select a calibration file to apply to the current
data file.

Table 4. Data Analysis windowmenu bar items, continued
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Tab Details
Each tab in the Data Analysis window displays data in charts and spreadsheets for a specific
analysis method and includes a well selector to select the data you want to show. When it opens,
the Data Analysis displays the Quantification tab by default. You can use the Amplification chart
data in the Quantification tab to determine the appropriate analysis settings for the run.

Note: The software links the data in the panes of each Data Analysis tab. For example,
highlighting a well by placing the mouse pointer over the well in the well selector view
highlights the data in all the other panes.

Step Number Selector
The CFX96 Touch™, CFX96 Touch Deep Well, CFX Connect™, and CFX384 Touch™ systems
can acquire fluorescence data at multiple protocol steps; the software maintains the data acquired
at each step independently. The software displays the Step Number selector below the Standard
Curve chart on the Quantification tab. When a protocol contains at least one data collection step,
CFX Maestro software for Mac displays the data from the first collection step.

If the protocol contains more than one collection step, you can select another the step from the
dropdown list, for example:
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When you select a step, the software applies that selection to all the data that are shown in the
Data Analysis window.

Viewing Well Groups in Data Analysis
Wells in the plate can be grouped into subsets for independent analysis using well groups. When
you create well groups, their group names appear in the Data Analysis window Well Groups
dropdown list on the toolbar.

If you created well groups, the software displays the default well group All Wells when you open
the Data Analysis window, displaying the data in all wells with content in the charts and
spreadsheets. Only the wells in that well group loaded with content appear in the well selector, and
only data for those wells are included in the data analysis calculations.

Tip: To create, edit, and delete well groups, click Manage Well Groups in the toolbar.

Note: If you did not create well groups, the Well Groups dropdown list does not appear in the
toolbar.

Changing Well Contents after a Run
During data analysis, changing the way the data are displayed by changing the contents of the
wells in the Plate Editor never changes the fluorescence data that were collected from each well
during the run. After the module collects fluorescence data, you cannot delete those data but you
can choose to remove data from view and analysis.

To change the content of wells after a run

u In the Data Analysis window, click Plate Setup and select one of the following options:

n Edit/View Plate— opens the Plate Editor, in which you can make manual changes to the
layout.

n Replace Plate file—opens the Select Plate browser, in which you can navigate to a
previously saved plate file with which to replace the current plate layout.

n Apply PrimePCR file— opens the Select PrimePCR file dialog box, in which you can
navigate to a PrimePCR™ run file and apply it to the plate layout.

Tip: You can add or edit information about the contents of the well before a run, during a run,
or after a PCR run completes. You must assign the scan mode and plate size before the run.
These parameters cannot change after the run.
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Data Analysis Settings
The Amplification chart data in the Quantification tab show the relative fluorescence (RFU) for each
well at every cycle. Each trace in the chart represents data from a single fluorophore in one well.
These data are used to determine Cq values for each well on a per fluorophore basis. The software
uses one of two modes to determine Cq values:

n Regression— applies a multivariable, nonlinear regression model to individual well traces
and then uses this model to compute an optimal Cq value.

n Single Threshold— uses a single threshold value to calculate the Cq value based on the
threshold crossing point of individual fluorescence traces.

Select Settings > Cq Determination Mode to choose the Cq determination mode.

Adjusting the Threshold
In Single Threshold mode, you can adjust the threshold for a fluorophore by clicking on the
threshold line in the Amplification chart and moving the mouse pointer vertically. Alternatively, you
can specify an exact crossing threshold for the selected fluorophore.

Baseline Settings
The software automatically sets the baseline individually for each well. The baseline setting
determines the method of baseline subtraction for all fluorescence traces. The software provides
three baseline subtraction options:

n No Baseline Subtraction— displays the data as relative fluorescence traces. Some analysis
is not possible in this analysis mode and therefore the software does not display the Gene
Expression, End Point, and Allelic Discrimination tabs.

n Baseline Subtracted— displays the data as baseline subtracted traces for each fluorophore
in a well. The software must baseline subtract the data to determine quantification cycles,
construct standard curves, and determine the concentration of unknown samples. To generate
a baseline subtracted trace, the software fits the best straight line through the recorded
fluorescence of each well during the baseline cycles and then subtracts the best fit data from
the background subtracted data at each cycle.

n Baseline Subtracted Curve Fit— displays the data as baseline subtracted traces and the
software smooths the baseline subtracted curve using a centered mean filter. This process is
performed so that each Cq is left invariant.
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In addition to these options, you can also select Apply Fluorescent Drift Correction. For wells that have
abnormally drifting RFU values during the initial few cycles of a run, the software derives an estimated
baseline from adjacent wells for which a horizontal baseline was successfully generated.

To change the baseline subtraction setting

u Select Settings > Baseline Setting.

Analysis Mode
Data can be grouped and analyzed by either fluorophore or target name. When grouped by
fluorophore, data traces are displayed by fluorophore as indicated in the plate setup for that run.
Individual fluorophore data appear in the amplification and standard curve chart (if available) when
the appropriate fluorophore selector checkboxes, located below the amplification chart, are selected.

When grouped by target, data traces are displayed by target name as entered in the plate setup for
that run.
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To choose a data analysis mode

u Do one of the following:

n Select Settings > Analysis Mode.

n Choose a mode from the Analysis Mode dropdown menu in the toolbar.

Cycles to Analyze
You can restrict the number of cycles to analyze. You can also analyze data from a specific set of
cycles. The maximum number cycles you can analyze is 50.

Note: Removing cycles from the beginning of a run can have a significant impact on
baselining.

To restrict data analysis to a specific range of cycles

1. Select Settings > Cycles to Analyze.

The Cycles to Analyze dialog box appears.

2. Enter the starting and ending cycle values and click OK.

Click Restore Defaults in the Cycles to Analyze dialog box to return to the cycles originally used for
analysis.
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Well Selector
Use the Well Selector to display or hide the well data in the charts or spreadsheets throughout the
Data Analysis window. Only wells loaded with sample can be selected in the well selector. The
software colors the wells in the Well Selector:

n Blue— indicates selected wells. The data from selected wells appear in the Data Analysis
window.

n Light gray— indicates unselected wells. The data from unselected wells do not appear in the
Data Analysis window.

n Dark gray— indicates empty wells.

To display or hide well data

u In the well selector, do any of the following:

n To hide one well, click the individual well. To display that well, click the well again.

n To hide multiple wells, drag across the wells you want to select. To display those wells,
drag across the wells again.

n Click the top left corner of the plate to hide all the wells. Click the top left corner again to
display all wells.

n Click the start of a column or row to hide those wells. Click the column or row again to
display the wells.
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Well Selector Right-Click Menu Items
Table 5 lists the right-click options available in the well selector view.

Item Function

Well XX Displays only this well, removes this well from view, set color for
this well, or excludes this well from analysis.

Selected Wells (right-click and
drag)

Displays only these wells, removes these wells from view, sets
color for these wells, or excludes these wells from analysis.

Copy Copies the content of the well to a clipboard, including Sample Type
and optional Replicate #.

Copy as Image Copies the well selector view as an image.

Print Prints the well selector view.

Print Selection Prints the current selection.

Export to Excel Exports the data to an Excel spreadsheet.

Export to Csv Exports the data as a text document.

Export to Xml Exports the data as an .xml document.

Well Labels Changes the well labels to Sample Type, Target Name, or Sample
Name.

Table 5. Right-click menu items in the well selectors
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Temporarily Excluding Wells from Analysis
To exclude wells from data analysis temporarily

1. Right-click the well in the well selector, on a fluorescence trace, or on a point plotted on the
standard curve. To exclude multiple wells, right-click and drag to highlight multiple wells,
traces, or points.

2. From the right-click menu, choose the appropriate option:

n Well > Exclude Well

n Selected Wells > Exclude from Analysis

n Selected Traces > Exclude these wells from Analysis

Alternatively, to permanently remove wells from analysis, clear the contents from wells in the
Plate Editor by clicking the Clear Wells button.

Important: You must reenter any well content that is cleared.

To include an excluded well

u Right-click the appropriate well in the well selector and select Well > Include Well in Analysis.
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Charts
Each chart in the Data Analysis window displays the data in a different graph and includes options
for adjusting the data.

Chart Tools
Chart tools appear in each chart in the Data Analysis window. All charts display the following tools:

Copy to Clipboard— copies the contents of the chart view to the clipboard.

Chart Settings— opens the Chart Settings dialog box in which you can modify the chart’s display
options including:

n Chart and axis titles

n Chart and axis font and size

n Axis scale

n Legend position

Export— opens the Export Options dialog box, from which you can modify the resolution and size
of the graph and save it to a specified location as one of the following file types:

n .bmp

n .jpg

n .png

Bar Chart Tools

In addition to the chart tools, bar charts display the following tools:

Sort— sorts the targets and samples alphabetically or in reverse alpha order.

Color Settings— opens the Color Settings dialog box, in which you can change the color of the
targets and samples.

For more information about these tools, see Changing and Annotating the Chart View on page
103.

Amplification Chart Tools

In addition to those listed above, amplification charts display the following tools:

Trace Styles— opens the Trace Styles dialog box, in which you can modify the appearance of
traces in the amplification chart.
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Baseline Threshold— opens the Baseline Threshold dialog box, in which you can modify the
default baseline for selected wells or change the threshold for each fluorescence curve in the
amplification chart.

Copying Chart Data to the Clipboard

You can copy the contents of the chart view and paste it into any application that accepts bitmap
image files.

To copy chart data to the clipboard

1. From the chart tools, select Copy to Clipboard.

2. Open an application that accepts bitmap images, for example Microsoft Word.

3. Right-click and select Paste to paste the bitmap image from the clipboard into the application.

Changing the Chart Display Settings

Use the Chart Settings dialog box to change the titles, fonts and sizes, axis scale, and legend
location for the displayed chart. Changes that you make apply to the displayed chart only and are
saved with the chart.

To change chart display settings

1. From the chart tools, click Chart Settings.

The Chart Settings dialog box appears.
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2. Select the Chart And Axes tab to:

n Type a title for the chart.

n Type a new title for the x-axis and angle the labels.

n Type a new title for the y-axis.

3. Select the Fonts tab to change the chart’s font and font size.

Tip: By default, the font size autoscales as the chart size changes. Select Change Font
Size to set a static font size for each label type.

4. Select the Axes Scale tab to:

n Clear x- and y-axis autoscaling and specify minimum and maximum scaling values.

n Choose to display grid lines or tick marks on the graph.

5. Select the Legend tab to:

n Choose to hide the chart legend.

n Change the default position of the chart legend.

Note:When the legend is positioned to the left or right of the chart, it displays only the first
ten fluorophores in the chart.

6. Click Apply at any time to view chart setting changes without saving the changes.

7. Click OK to save the changes and return to the chart.

Exporting the Chart

Use this dialog box to modify the width, height, and resolution of the graph to export it in one of the
following file formats:

n .bmp

n .jpg

n .png

You can the use the exported graph to display your results in poster sessions, Microsoft
PowerPoint presentations, and professional journals.

Note: Consider the following when modifying the settings:

n Maximum and minimum width and height limits

o At 72 dpi: 0.1–83 in

o At 96 dpi: 0.1–62 in
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o At 150 dpi: 0.1–40 in

o At 300 dpi: 0.1–20 in

o At 600 dpi: 0.1–10 in

o At all resolutions: 2–6,000 pixels

n Aspect ratio is based on width.

To export the chart

1. From the chart tools, click Export.

The Export Preview dialog box appears.

2. Modify the settings for the display as required.

3. Click Export.

4. In the Export dialog box, do the following:

a. (Optional) Navigate to a folder in which to save the chart file.

b. Type a name for the file and choose a file type from the dropdown list.

5. Click Save to save the chart file.

Modifying the Baseline Threshold Settings

In Single Threshold mode, you can adjust the threshold for a fluorophore by clicking on the
threshold line in the Amplification chart and moving the mouse pointer vertically. Alternatively, you
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can specify an exact crossing threshold for the selected fluorophore.

Tip: You can specify a cycle range to determine the baseline for all data files in the Data
Analysis tab in User > User Preferences.

To adjust the begin and end baseline cycle for each well

1. In the Quantification tab, select a single fluorophore under the Amplification chart.

2. From the chart tools, select Baseline Threshold.

The Baseline Threshold dialog box appears.
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3. In the Baseline Cycles section, do one of the following:

n To select one well, click its row number.

n To select multiple adjacent wells, click the row number of the first well and drag down the
column to the final well.

n To select multiple nonadjacent wells, press the Control key and click the row number of
each target well.

n To select all wells, click the top left corner on the table.

4. Adjust the Baseline Begin cycle and Baseline End cycle for all selected wells, or change the
Begin and End cycle number at the bottom of the spreadsheet.

Tip: To revert the settings back to the last saved values, click Reset All User Defined
Values.

5. Click OK to save the changes and return to the chart.

To specify a cycle range for all data files

u In the Home or Plate Editor window, select User > User Preferences and choose the Data
Analysis tab.
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Sorting Target, Sample, and Biological Group Data

Note: This option is available on gene expression charts only.

By default, the Targets, Samples, and Biological Groups lists appear in alphabetical order. Use the
Sort dialog box to sort the display in reverse alpha order or to manually move a term to a different
position in the list.

To sort target, sample, and biological group data

1. From the chart tools, click Sort.

The Gene Expression Chart Sorting dialog box appears.

2. In the dialog box, click Z-A to sort the list in reverse alphabetical order.

3. To manually move a term, select it and click the appropriate button between the charts:

n Click the Up or Down arrow to move the selected term one position.

n Click the Up or Down bar arrow to move the selected term to the top or bottom of the list.

4. Click OK to save the changes and return to the Gene Expression tab.
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Changing the Target and Sample Color Settings

Note: This option is available on gene expression charts only.

Use the Color Settings dialog box to change the color of a target or sample, or to remove the item
from the graph.

To change color settings

1. From the chart tools, select Color Settings.

The Color Settings dialog box appears.

2. To change the display color for a target or sample, click its color in the Color column.

3. In the Color dialog box that appears, select a new color and click OK.

4. To remove the item from the gene expression graph, clear its checkbox in the Show Chart
column.

Tip: To clear all items from the gene expression graph, clear the Show Chart checkbox in
the column head.

5. (Optional) By default, the bar chart color appears in gradient form. To display the color in solid
form, select Use Solid Colors.

6. Click OK to save the changes and return to the Gene Expression tab.
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Magnifying an Area in the Chart
To magnify an area of the chart

u Click and drag across the chart. The software resizes the chart and centers it on the selected
area.

To reset the chart to full view

u Right-click in the chart and select Set Scale to Default.

Copying Charts into a Microsoft File
You can copy data charts into Microsoft Word, Excel, or PowerPoint documents. The image
resolution corresponds to that of the screen from which the image was obtained

To copy charts into a Microsoft file

1. In the Data Analysis window, click Copy To Clipboard in the upper right corner of the chart’s
pane.

2. Open a blank Microsoft file and paste the contents from the clipboard.

Common Right-Click Menu Items for Charts
Table 6 lists the right-click menu items that are available on charts. Some of the available items are
present for all charts, and these items can be used to change how the data are displayed or to
easily export the data from a chart.

Item Function

Copy Copies the chart into the clipboard.

Save Image As Saves the image at a specified size, resolution, and file type. The image
formats available are PNG (default), JPG, and BMP.

Set Scale to Default Returns the chart to its default view after magnifying the chart.

Chart Options Opens the Chart Options window to change the chart, including
changing the title, selecting limits for the x and y axes, showing grid
lines, and showing minor ticks in the axes.

Table 6. Right-click menu items for charts

Note: Menu items that apply to specific charts are described in Chapter 6, Data Analysis
Details.
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Spreadsheets
The spreadsheets shown in Data Analysis include options for sorting and transferring the data.
Sort the columns by one of these methods:

n Click and drag a column to a new location in the selected table.

n Click the column header to sort the data in ascending or descending order.

To sort up to three columns of data in the Sort window

1. Right-click in the spreadsheet and select Sort.

2. In the Sort dialog box, select the first column title to sort. Sort the data in ascending or
descending order.

3. Select a second or third column to sort and choose Ascending or Descending.

4. Click OK to sort the data or click Cancel to stop sorting.

Highlight the data on the associated charts and well selector by holding the mouse pointer over a
cell. Click in a cell to copy and paste its contents into another software program.

Common Right-Click Menu Items for Spreadsheets
Table 7 lists the right-click menu items available on any spreadsheet view.

Item Function

Copy Copies the contents of the selected wells to a clipboard, then paste
the contents into a spreadsheet such as Excel.

Copy as Image Copies the spreadsheet view as an image file and paste it into a file
that accepts an image file, such as text, image, or spreadsheet
files.

Print Prints the current view.

Print Selection Prints the current selection.

Export to Excel Exports the data to an Excel spreadsheet.

Export to Text Exports the data to a text editor.

Export to Xml Exports the data to an Xml file.

Table 7. Right-click menu items for spreadsheets
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Item Function

Export to Html Exports the data to an Html file.

Find Searches for text.

Sort Sorts the data in up to three columns.

Select Columns Selects the columns that will be displayed in the spreadsheet.

Table 7. Right-click menu items for spreadsheets, continued
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Export
CFX Maestro software for Mac provides four export options from the Export dropdown menu:

n Export All Data Sheets to Excel

n Export RDML Files

n Custom Export

n Export to LIMS

Exporting All Data Sheets to Excel
You can export all the spreadsheet views from every tab of CFX Maestro software for Mac into
individual Excel files.

To export all data sheets to Excel

u Select Export > Export All Data Sheets to Excel.

Exporting RDML Files
RDML is a structured and universal data standard for exchanging quantitative PCR (qPCR) data.
The data standard is a text file in Extensible Markup Language (.xml) format. Refer to the
International RDML Consortium website (www.rdml.org) for additional information about the RDML
data exchange format.

Note: Save the RDML file as version 1.1 if you are using version 2.3 or higher of qbase+
software.

To export an RDML file

1. Select Export > Export RDML Files and select RDML v1.1 or RDML v1.0 from the list that
appears.

The Save As dialog box appears.

2. In the Save As dialog box, specify a file name and location in which to save the RDML file.

3. Click OK to save the export file.
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Creating a Custom Export File
To create a custom export file

1. Select Export > Custom Export. The Custom Export dialog box appears.

2. Select the export format from the dropdown list that appears.

3. Select the checkboxes for the items to export.

4. (Optional) Click Customize Column Names to change column names.

5. Click Export. The Save As dialog box appears.

6. In the Save As dialog box, specify a file name and location in which to save the exported file.

7. Click OK to save the export file.
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Exporting to a LIMS Folder
You can export data into a LIMS-compatible file format.

To export data in LIMS format

1. Select Export > Export to LIMS Folder.

The Save As dialog box appears.

2. In the Save As dialog box, specify a file name and location in which to save the exported file.

3. Click OK to save the export file.
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Chapter 6 Data Analysis Details
The Data Analysis window comprises multiple tabs from which to view data. This chapter explains
these tabs in detail.

Tip: You can choose which tabs to view in the Data Analysis window using the View menu.
The customized layout is saved with the data file.
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Quantification Tab
Use the data in the Quantification tab to set the data analysis conditions, including the baseline
settings for individual wells and the threshold settings. The Quantification tab displays data in
these four views:

n Amplification chart — displays the relative fluorescence units (RFU) for each well at every
cycle. Each trace in the chart represents data from a single fluorophore in one well.

n Standard curve — appears only if the run includes wells designated as sample type standard
(Std). The standard curve displays the threshold cycle plotted against the log of the starting
quantity. The legend displays the Reaction Efficiency (E) for each fluorophore in the wells with
a Standard sample type.

n Well selector — selects the wells with the fluorescence data you want to show.

n Spreadsheet — displays a spreadsheet of the data collected in the selected wells.
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Fluorophore Options
To display flourophore data in the Quantification tab charts and spreadsheets, select the target
fluorophore(s) below the Amplification chart. To hide the fluorophore data in the data analysis
window, clear its checkbox.

Trace Styles Dialog Box
Using the Trace Styles dialog box, you can adjust the appearance of traces in the amplification and
melt curve charts in the Quantification and Melt Curve tabs. You can then preview the changes in
the well selector that appears in the Trace Styles dialog box.

To adjust trace styles

1. Select only one fluorophore under the Amplification chart.

2. To open the Trace Styles dialog box, do one of the following:

n Click Trace Styles in the Amplification chart.

n Select Settings > Trace Styles in the Data Analysis menu bar.

n Right-click on a trace and select Trace Styles.

The Trace Styles dialog appears.

User Guide | 63



Chapter 6 Data AnalysisDetails

3. In the Trace Styles dialog box, select a specific set of wells in the well selector in the bottom
pane. Alternatively, select wells that contain one sample type in the dropdown menu in the
Wells column.

4. Do any of the following:

n To choose a color for the selected wells, click the box in the Color column.

n To assign a symbol to the selected wells, select a symbol from the Symbol dropdown list.

n To quickly color the wells by button label, click the appropriate quick set:

o Random by Well

o Random by Replicate

o Use Fluor Colors

o Use Target Colors

o Use Sample Colors

n To assign well labels, choose either Sample Type, Target Name, Sample Name, or
Symbol.

Log Scale Option
Select Log Scale below the Amplification chart to view the fluorescence traces in a semilog scale:

Tip: To magnify any area of the chart, drag across the target area. To return to a full view, right-
click on the chart and select Set Scale to Default.
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Standard Curve Chart
The software creates a Standard Curve chart in the Quantification tab if the data include sample
types defined as Std for at least one fluorophore in the run.

The Standard Curve chart displays the following information:

n Name for each curve (the fluorophore or target).

n Color of each fluorophore or target.

n Reaction efficiency (E). Use this statistic to optimize a multiplex reaction and to equalize the
data for a standard curve.

Note: The reaction efficiency describes how much of your target is being produced with
each cycle in the protocol. An efficiency of 100% indicates that you are doubling your
target with each cycle.

n Coefficient of determination, R2 (written as R^2). Use this statistic to determine how correctly
the line describes the data (goodness of fit).

n Slope

n y-intercept
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Amplification Chart Menu Options
In addition to the common right-click menu options to copy, print, and export charts, Table 8 lists
the menu options available only on the Amplification chart.

Menu Option Function

Well XX, Fluor Target Displays only this well, removes this well from view, sets color for
this trace, or excludes this well from analysis.

Selected Traces Displays only these wells, removes these wells from view, sets
color for these traces, or excludes these wells from analysis.

Show Threshold Values Displays the threshold value for each amplification curve on the
chart.

Trace Styles Opens the Trace Styles window to change trace styles that appear
on the Quantification and Melt Curve tabs.

Baseline Thresholds Opens the Baseline Thresholds window to change the baseline or
thresholds of each fluorophore (changes appear in the
Amplification chart in the Quantification tab).

Table 8. Amplification chart right- and left-click menu items

Quantification Tab Spreadsheet
Table 9 defines the data displayed in the spreadsheet in the Quantification tab.

Information Description

Well Well position in the plate

Fluor Fluorophore detected

Target Target Name loaded in the Plate Editor wells

Content A combination of the Sample Type (required) and Replicate #
(optional) loaded in the Plate Editor

Sample Sample Name loaded in the Plate Editor wells

Cq Quantification cycle for each trace

Table 9. Quantification tab spreadsheet content
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Changing Target, Content, or Sample Data

You can change the data in the Target, Content, and Sample columns by editing the plate file
using the Plate Editor even after you run the experiment.

To change the data in the Content, Target, and Sample columns

u Click Plate Setup and select View/Edit Plate to open the Plate Editor.
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Quantification Data Tab
The Quantification Data tab displays the quantification data collected in each well. CFX Maestro
software for Mac displays the data in four different spreadsheet views:

n Results — displays a spreadsheet of the data. This is the default view.

n Standard Curve Results — displays a spreadsheet of the standard curve data.

n Plate — displays the data in each well as a plate map.

n RFU — displays the RFU quantities in each well for each cycle.

Select each spreadsheet from the dropdown list that appears below the Quantification Data tab.

Results Spreadsheet
The Results spreadsheet displays data for each well in the plate.

Note: All Std. Dev (standard deviation) calculations apply to the replicate groups assigned in
the wells in the Plate Editor window. The calculations average the Cq value for each well in
the replicate group.

Table 10 defines the data that appear in the Results spreadsheet.

Information Description

Well Well position in the plate

Fluor Fluorophore detected

Target Amplification target name (gene)

Content Sample type and Replicate #

Table 10. Results spreadsheet content
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Information Description

Sample Sample description

Biological Set Name Name of the biological set

Cq Quantification cycle

Cq Mean Mean of the quantification cycle for the replicate group

Cq Std. Dev Standard deviation of the quantification cycle for the replicate group

Starting Quantity (SQ) Estimate of the starting quantity of the target

Log Starting Quantity Log of the starting quantity

SQ Mean Mean of the starting quantity

SQ Std. Dev Standard deviation of the starting quantity across replicates

Set Point Temperature of sample in the well for a gradient step across
replicates

Table 10. Results spreadsheet content, continued
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Standard Curve Results Spreadsheet
The Standard Curve Results spreadsheet displays the calculated standard curve parameters.

Table 11 defines the data that appear in the Standard Curve Results spreadsheet.

Information Description

Fluor (or Target) Fluorophore (or Target) detected

Efficiency % Reaction efficiency

Slope Slope of the standard curve

Y-intercept Point at which the curve intercepts the y-axis

R^2 Coefficient of determination

Table 11. Standard Curve Results spreadsheet contents
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Plate Spreadsheet
The Plate spreadsheet displays a plate map of the data for one fluorophore at a time.

To view data for a specific fluorophore

u Click its tab at the bottom of the spreadsheet.
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RFU Spreadsheet
The RFU spreadsheet displays the relative fluorescence units (RFU) readings for each well
acquired at each cycle of the run. The well number appears at the top of each column and the
cycle number appears to the left of each row.

72 | CFXMaestro Software for Mac



Melt Curve Tab

Melt Curve Tab
For DNA-binding dyes and noncleavable hybridization probes, the fluorescence is brightest when
the two strands of DNA anneal. Therefore, as the temperature rises towards the melting
temperature (Tm), fluorescence decreases at a constant rate (constant slope). At the Tm there is a
dramatic reduction in the fluorescence with a noticeable change in slope. The rate of this change is
determined by plotting the negative first regression of fluorescence versus temperature (-d
(RFU)/dT). The greatest rate of change in fluorescence results in visible peaks and represents the
Tm of the double-stranded DNA complexes.

The software plots the RFU data collected during a melt curve as a function of temperature. To
analyze melt peak data, the software assigns a beginning and ending temperature to each peak by
moving the threshold bar. The floor of the peak area is specified by the position of the melt
threshold bar. A valid peak must have a minimum height relative to the distance between the
threshold bar and the height of the highest peak.

The Melt Curve tab displays the Tm of amplified PCR products in four views:

n Melt Curve — displays the real-time data for each fluorophore as RFUs per temperature for
each well.

n Melt Peak — displays the negative regression of the RFU data per temperature for each well.

n Well selector — displays wells to show or hide the data.

n Peak spreadsheet — displays the data collected in the selected well.

Note: This spreadsheet displays up to two peaks for each trace. To see more peaks, click
the Melt Curve Data tab.
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Adjusting Melt Curve Data
To adjust the Melt Curve data

u Do any of the following:

n Click and drag the threshold bars in the Melt Peak chart to include or exclude peaks in
data analysis.

n Select Positive in the Peaks dropdown menu to show the spreadsheet data for the peaks
above the Melt Threshold line or select Negative to view the spreadsheet data for the
peaks below the Melt Threshold line.

n Open the Trace Styles window to change the color of the traces in the Melt Curve and Melt
Peak charts.

n Select a number in the Step Number selector to view the Melt Curve data at another step
in the protocol. The list shows more than one step if the protocol includes plate reads in
more than one melt curve step.

n Select wells in the well selector to focus on subsets of the data.

n Select a well group to view and analyze a subset of the wells in the plate. Select each well
group by name in the Well Group dropdown menu in the toolbar.
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Melt Curve Data Tab
The Melt Curve Data tab displays the data from the Melt Curve tab in multiple spreadsheets that
include all the melt peaks for each trace. CFX Maestro software for Mac offers four spreadsheet
options in which to view the melt curve data:

n Melt Peaks — displays all the data, including all the melt peaks, for each trace. This is the
default view.

n Plate — displays a view of the data and contents of each well in the plate.

n RFU — displays the RFU quantities at each temperature for each well.

n -d(RFU)/dT— displays the negative rate of change in RFU as the temperature (T) changes.
This is a first regression plot for each well in the plate.

Select each spreadsheet from the dropdown list that appears below the Melt Curve Data tab.

Melt Peaks Spreadsheet
The Melt Peaks spreadsheet displays all melt curve data.

Table 12 on page 76 defines the data that appear in the Melt Peaks spreadsheet.
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Information Description

Well Well position in the plate

Fluor Fluorophore detected

Content Sample Type listed in the Plate Editor window

Target Amplification target (gene)

Sample Sample Name listed in the Plate Editor window

Melt Temperature The melting temperature of each product, listed as one peak
(highest) per row in the spreadsheet

Peak Height Height of the peak

Begin Temperature Temperature at the beginning of the peak

End Temperature Temperature at the end of the peak

Table 12. Melt Peaks spreadsheet content
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Plate Spreadsheet
The Plate spreadsheet displays melt curve data in a plate format.

Note: To adjust the peak that the software calls, adjust the threshold line in the Melt Peak chart
on the Melt Curve tab.

Table 13 on page 77 defines the data that appear in the Plate spreadsheet.

Information Description

Content A combination of Sample Type (required) and Replicate # (optional)

Sample Sample description

Peak 1 First melt peak (highest)

Peak 2 Second (lower) melt peak

Table 13. Plate spreadsheet content
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RFU Spreadsheet
The RFU spreadsheet displays the fluorescence for each well at each cycle acquired during the
melt curve.

Table 14 defines the data displayed in the RFU spreadsheet.

Information Description

Well number (A1, A2, A3, A4, A5) Well position in the plate for the loaded wells

Temperature Melting temperature of the amplified target,
plotted as one well per row and multiple wells
for multiple products in the same well

Table 14. RFU spreadsheet content
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-d(RFU)/dT Spreadsheet
The -d(RFU)/dT spreadsheet displays the negative rate of change in RFU as the temperature (T)
changes.

Table 15 defines the data that appear in the -d(RFU)/dT spreadsheet.

Information Description

Well number (A1, A2, A3, A4, A5) Well position in the plate for the loaded wells

Temperature -d(RFU)/dT Negative rate of change in RFU as temperature (T)
changes

Table 15. -d(RFU)/dT spreadsheet content
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End Point Tab
Open the End Point tab to analyze final relative fluorescence units (RFUs) for the sample wells.
The software compares the RFU levels for wells with unknown samples to the RFU levels for wells
with negative controls and “calls” the unknown positive or negative. Positive samples have an RFU
value that is greater than the average RFU value of the negative controls plus the cut off value.

To analyze the end-point data, the plate must contain negative controls or the software cannot
make the call.

The End Point tab displays the average RFU values to determine whether the target was amplified
by the last (end) cycle. Use these data to determine whether a specific target sequence is present
(positive) in a sample. Positive targets have higher RFU values than the cutoff level you define.

The End Point tab comprises the following sections:

n Settings — adjusts data analysis settings.

n Results — displays the results immediately after you adjust the settings.

n Well Selector — selects the wells with the end-point data you want to show.

n RFU spreadsheet — displays the end RFU collected in the selected wells.
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Results Data
The Results section displays the following data:

n Lowest RFU value — lowest RFU value in the data

n Highest RFU value — highest RFU value in the data

n Negative Control Average — average RFU for the wells that contain negative controls

n Cut Off Value — calculated by adding the tolerance (RFU or Percentage of Range listed in the
Settings) and the average of the negative controls. Samples with RFUs that are greater than
the cutoff value will be called “Positive.” To adjust the cutoff value, change the RFU or
Percentage of Range

The Cut Off Value is calculated using this formula:

Cut Off Value = Negative Control Average + Tolerance

Select a tolerance by one of these methods:

n RFUs (default) — select this method to use an absolute RFU value for the tolerance. The
minimum RFU tolerance value is 2. The maximum is the absolute value of the highest RFU
value minus the absolute value of the lowest RFU value. The default RFU tolerance value is
10% of the total RFU range.

n Percent of Range — select this method to use a percentage of the RFU range for the
tolerance. The minimum percent of range is 1%. The maximum percent of range is 99%. The
default percent of range is 10%.
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Adjusting the End Point Data Analysis
To adjust the data in the End Point tab

u Do any of the following:

n Choose a fluorophore from the dropdown list.

n Choose an End Cycle to Average value to set the number of cycles with which to calculate
the average end-point RFU.

n Select RFUs to view the data in relative fluorescence units.

n Select Percentage of Range to view the data as a percentage of the RFU range.

n Select wells in the well selector to focus on subsets of the data.

n Select a well group to view and analyze a subset of the wells in the plate. Select each well
group by name in the Well Group dropdown menu in the toolbar.

RFU Spreadsheet for End Point Analysis
Table 16 defines the data that appear in the RFU spreadsheet in the End Point tab.

Information Description

Well Well position in the plate

Fluor Fluorophore detected

Content A combination of the Sample type and Replicate #

End RFU RFU at the end-point cycle

Call Positive or Negative, where positive samples have an RFU value greater
than the average RFU of the negative controls plus the Cut Off Value

Sample Sample Name loaded in the Plate Editor

Table 16. End Point spreadsheet contents
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Allelic Discrimination Tab
The Allelic Discrimination tab assigns genotypes to wells with unknown samples. Use these data
to identify samples with different genotypes, including Allele 1, Allele 2, Heterozygote, No Call (no
amplification), or Undetermined.

Note: The data for allelic discrimination must come from multiplex runs with at least two
fluorophores. Each fluorophore identifies one allele in all samples.

Allelic discrimination analysis requires the following minimal well contents:

n Two fluorophores in each well

n NTC (no template control) samples for optimized data analysis

CFX Maestro software for Mac offers four options in which to view allelic discrimination data:

n Allelic Discrimination chart — displays the data in a graph of RFU for Allele 1/Allele 2. Each
point in the graph represents data from both fluorophores in one well. You can toggle between
Cartesian and Polar coordinates by selecting and clearing the Polar Coordinates checkbox.
Cartesian Coordinates represents RFU for Allele 1 on the x-axis and RFU for Allele 2 on the
y-axis. Polar Coordinates represents the angle on the x-axis and the RFU distance on the
y-axis from the origin (median of all NTC).
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n Well spreadsheet — displays the allelic discrimination data collected in each well of the plate.

n Well selector — selects the wells with the allelic data you want to show.

n Selected Fluorophores panel — changes the x- and y-axis labels in the Allelic Discrimination
chart, the cycle to analyze, and whether to display the call map.

Adjusting Data for Allelic Discrimination
The software automatically assigns a genotype to wells with unknown samples based on the
positions of the NTCs and the angle and distance of the unknown data points from the NTCs.

To adjust allelic discrimination data

u Do any of the following:

n To display polar coordinates, select the checkbox in the Allelic Discrimination chart.

n To view another fluorophore, choose it from the dropdown list in the Selected
Fluorophores panel.

n To change a call, drag across the data point(s) in the Allelic Discrimination chart and
choose an option in the Selected Wells list:

o Allele 1

o Allele 2

o Heterozygote

o Undetermined

o No Call

o Auto Call

Tip: Select Auto Call to revert to the default call.
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Chart Menu Options
In addition to the common right-click menu options to copy, print, and export charts, Table 17 lists
the menu options available on the Allelic Discrimination chart.

Menu Option Function

Zoom Focuses in the selected area when more than one data point is
selected.

Well Displays only this well, removes this well from view, sets color for
this trace, or excludes this well from analysis when clicked on a
single trace.

Selected Wells Displays only these wells, removes these wells from view, sets
color for these traces, or excludes these wells from analysis when
multiple traces are selected.

Table 17. Allelic Discrimination chart right- and left-menu options

Allelic Discrimination Spreadsheet
Table 18 defines the data that appear in the Allelic Discrimination spreadsheet.

Information Description

Well Well position in the plate

Sample Sample name description

Call Identity of the allele, including automatic Allele 1, Allele 2,
Heterozygote, No Call, or Undetermined

Type Auto (Automatic) or Manual, describes how the call was made.
Automatic indicates that the software selected the call. Manual
indicates that the user chose the call

RFU1 RFU for Allele1

RFU2 RFU for Allele2

Table 18. Allelic Discrimination spreadsheet contents
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Custom Data View Tab
The Custom Data View tab simultaneously displays multiple panes in a customizable format.

The Load a Preset View dropdown list offers a selection of display format templates. The default
view displayed is dependent on the file being analyzed. For example, if Melt Curve data are
present, the Amp+Melt default view appears.
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Creating a Custom Data View
To create a custom data view

u Do any of the following:

n Select an alternate preset view from the dropdown list.

n Select another chart view from the dropdown list located at the top of each individual
pane.

n Change the number of rows and columns in the tab.

n Change individual pane dimensions. Drag the bars at the periphery of each pane.

Click Save as Preset to save the customized as a preset template. Click Manage Presets to delete,
rename, or restore existing preset views.
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QC Tab
Use the QC tab to quickly assess the quality of the run data based on the rules defined in the QC
rules table.

CFX Maestro software for Mac offers four options in which to view the QC data:

n Amplification chart— displays the RFU for each well at every cycle. Each trace in the chart
represents data from a single fluorophore in one well.

n QC rules table— displays the available QC rules and the settings that define each rule.
Applied QC rules are indicated by a checkmark.

n Well selector— selects the wells with the fluorescence data you want to show.

n QC rule summary pane— displays the selected QC rule and highlights wells that fail the rule.

Changing QC Criteria
To change QC criteria

u Select or clear the Use checkbox for the rule to include or exclude from QC.
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Excluding Wells That Fail QC
CFX Maestro software for Mac displays wells that fail QC criteria in the Results column in the QC
rules table and in the summary pane.

To exclude wells that fail QC criteria

u Select Exclude Wells for each well to exclude.
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Run Information Tab
The Run Information tab displays the protocol and other information about each run. Use this tab to
do the following:

n View the protocol.

n Enter or edit notes about the run.

n Enter or edit the ID or bar code for the run.

n View events that might have occurred during the run. Use these messages to help
troubleshoot a run.

Tip: Right-click the Protocol to copy, export, or print it. Right-click the Notes, ID/Bar Code, or
Other panes to undo, cut, copy, paste, delete, or select the text.
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Data Analysis Reports
The Report dialog comprises the following sections:

n Menu and toolbar — provides options to format, save, and print the report or template.

n Options list (top left side of the dialog box) — provides options to display in the report.

n Options pane (bottom left side of the dialog box) — displays text boxes in which you can enter
information about a selected option.

n Preview pane (right side of the dialog box) — displays a preview of the current report.

User Guide | 91



Chapter 6 Data AnalysisDetails

Data Analysis Report Categories
Table 19 lists all the options available for a data analysis report, depending on the type of data in
the Data Analysis window.

Category Option Description

Header

Title, subtitle, and logo for the report

Report Information Run date, user name, data file name,
data file path, and selected well group

Audit Information Supplementary information required for
auditing, including signatures

Notes Notes about the data report

Run Setup

Run Information Run date, user name, data file name,
data file path, and selected well group

Protocol Text view of the protocol steps and
options

Plate Display Plate view of the information in each
well of the plate

Quantification

Analysis Settings Data collection step number, analysis
mode, and baseline subtraction method

Amplification Chart Amplification chart for runs that include
quantification data

Standard Curve Chart Standard curve chart

Data Spreadsheet listing the data in each
well

Table 19. Data analysis report categories in the options list
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Category Option Description

Gene Expression— Bar Chart

Analysis Settings Analysis mode, chart data, scaling
option, and chart error

Chart Copy of the bar chart

Target Names Chart of target names

Sample Names Chart of sample names

Data Spreadsheet listing the data in each
well

Target Stability Chart of the target stability values

Box-and-Whisker Chart Box-and-whisker chart

Dot Plot Chart Dot plot chart

Gene Expression— Clustergram, Scatter Plot, Volcano Plot, and Heat Map

Analysis Settings Settings for each chart type

Chart Copy of the chart

Data Spreadsheet listing the data in each
target

Gene Expression— ANOVA Data

ANOVA Settings P-value threshold used in the analysis

ANOVA Results Table of results from ANOVA and
Tukey's HSD post-hoc analysis

Shapiro-Wilk Normality Test Biological group, count, P-value, and
errors that occur for each target in the
analysis

ANOVA Errors Errors identified during ANOVA
calculations

Table 19. Data analysis report categories in the options list, continued
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Category Option Description

Melt Curve

Analysis Settings Melt step number and threshold bar
setting

Melt Curve Chart Melt curve chart

Melt Peak Chart Melt peak chart

Data Spreadsheet listing the data in each
well

Allelic Discrimination

Analysis Settings Displays fluorophores, cycle, and view
call map

Allelic Discrimination Chart Copy of the allelic discrimination chart

Data Spreadsheet listing the data in each
well

End Point

Analysis Settings Fluorophore, end cycles to average,
mode, lowest RFU value, highest RFU
value, and cut off value

Data Spreadsheet listing the data in each
well

QC Parameters

Data Spreadsheet listing the parameters for
each QC rule

Table 19. Data analysis report categories in the options list, continued
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Creating a Data Analysis Report
You can save the report layout as a template, which you can use again for similar reports.

To create a data analysis report

1. Make final adjustments to the well contents, selected wells, charts, and spreadsheets in the
Data Analysis window before creating the report.

2. Select Tools > Reports in the Data Analysis menu bar to open the Report dialog box.

3. Choose the options you want to include in the report. The report opens with default options
selected. Select or clear the checkboxes to change whole categories or individual options
within a category.

Table 19 on page 92 lists the available options to display.

Note: The data that appear in the report depend on the current selections within the tabs
of the Data Analysis or window. For example, a quantification run might not contain a
standard curve, and therefore those data do not appear in the Data Analysis window or in
the data report.

4. Change the order of categories and items in a report. Drag the options to the relative position.
Items can be reordered only within the categories to which they belong.

5. (Optional) In the Report Options pane, enter information relevant to the selected option:

n Choose a subset of information to display in the report.

n Choose specific settings for the selected option.

n Change the text to display for the selected option.

6. Click Update Report to update the Report Preview with any changes.

7. Print or save the report. Click the Print Report button in the toolbar to print the current report.
Select File > Save to save the report in PDF (Adobe Acrobat Reader file) format and select a
location in which to save the file. Select File > Save As to save the report with a new name or
in a new location.

8. (Optional) Create a report template with the information you want. To save the current report
settings in a template, select Template > Save or Save As. Then load the report template the
next time you want to make a new report.
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Creating Well Group Reports
To create a well group report

1. Select Tools > Well Group Reports in the Data Analysis window.

2. In the Well Groups Reports dialog box, select the well groups, amplification steps, and melt
steps to include in the report.

3. Enter the path or navigate to the destination folder in which to save the report.

4. (Optional) Select Choose a Report Template and navigate to the template file folder.

5. (Optional) Select Open Destination Folder to open the folder and view the reports after they
are generated.

6. Click Create Reports.
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With the use of stringently qualified controls in your reactions, you can perform a gene expression
run to normalize the relative differences in a target concentration among samples. Typically,
expression levels for one or more reference genes are used to normalize the expression levels of
a gene of interest. Reference genes take into account loading differences or other variations
represented in each sample and their expression levels should not be affected in the biological
system being studied.

Choose the Gene Expression tab in the Data Analysis window to evaluate relative differences
between PCR reactions in two or more wells. For example, you can evaluate relative numbers of
viral genomes or relative numbers of transfected sequences in a PCR reaction. The most common
application for gene expression study is the comparison of cDNA concentration in more than one
reaction to estimate the levels of steady state messenger RNA.

The software calculates the relative expression level of a target with one of these scenarios:

n Relative expression level of a target sequence (Target 1) relative to another target (Target 2);
for example the amount of one gene relative to another gene under the same sample
treatment.

n Relative expression level of one target sequence in one sample compared to the same target
under different sample treatment;. for example, the relative amount of one gene relative to
itself under different temporal, geographical, or developmental conditions.

Plate Setup for Gene Expression Analysis
To perform gene expression analysis, the contents of the wells must include the following:

n Two or more targets — the two targets that represent different amplified genes or sequences in
your samples.

n One or more reference targets — at least one target must be a reference target for normalized
expression. Assign all reference targets in the Experiment Settings window to analyze the data
in Normalized Expression mode (ΔΔCq). Runs that do not contain a reference must be
analyzed using Relative Expression mode (ΔCq).

n Common samples — your reactions must include common samples (minimum of two required)
to view your data plotted in the Gene Expression tab. These samples should represent
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different treatments or conditions for each of your target sequences. Assign a control sample
(optional) in the Experiment Settings window. If no control is selected, the software uses the
lowest Cq as the control.

The requirements for Gene Expression setup in the Plate Editor depend on whether reaction
contents are singleplex PCR, with one fluorophore in the reactions, or multiplex PCR, with more
than one fluorophore in the reactions.

Guided Plate Setup
If the plate setup of a data file does not contain the information required for analysis and the Gene
Expression tab is selected, the space normally occupied by the bar chart will contain instructions
for entering this information. For normalized gene expression, complete the following steps:

1. Define Target and Sample names using any of the following:

n Plate Setup — opens the Plate Editor window.

n Replace Plate File — opens the Select Plate browser, in which you can navigate to a
previously saved plate file with which to replace the current plate layout.

n Replace PrimePCR File — opens the Select PrimePCR file dialog box, in which you can
navigate to a PrimePCR™ run file and apply it to the plate layout.

2. Select one or more reference targets and a control sample using the Experiment Settings
dialog box.

If the plate layout already contains target and sample information, only the second step is
required and is highlighted orange. This step must be completed before normalized gene
expression analysis can occur.

Note: Data for the clustergram, scatter plot, heat maps, and volcano plot are displayed
only if all of the requirements for normalized gene expression listed under Plate Setup for
Gene Expression Analysis are met.
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Gene Expression Charts
CFX Maestro™ software displays gene expression data in multiple views. Table 20 lists chart
options available in the software.

Button Name Function

Graphing Displays normalized gene expression data
in one of the following views:

n Bar chart (the default)

n Box and whisker chart

n Dot plot chart

Clustergram Displays the normalized expression data in
a hierarchy based on the degree of similarity
of expression for different targets and
samples.

Scatter Plot Displays the normalized expression of
targets for a control versus an experimental
sample.

Volcano Plot Displays the relative expression of targets
in the selected biological group as
compared to the control group and indicates
the degree of significance based on the P-
value.

Heat Map Displays a visual depiction of the regulation
of targets for an experimental sample
compared to a control sample based on
relative normalized expression and its
location on a plate.

ANOVA Displays the results of one-way ANOVA on
the gene expression data using the following
R packages to perform ANOVA and
determine Tukey results:

n Companion to Applied Regression (car)

n Least-square means (lsmeans)

Table 20. Gene expression chart options
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Button Name Function

Reference Gene Selection Tool (Available on the Study Analysis tab in the
Gene Study window) Identifies the tested
reference genes and categorizes them as
Ideal, Acceptable, or Unstable based on
their stability.

PrimePCR Controls Analysis (Available on the Study Analysis tab in the
Gene Study window) Displays the results of
the tested samples.

Table 20. Gene expression chart options, continued
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Graphing

The relative expression of targets is presented in these two views:

n Gene Expression chart — displays the real-time PCR data as one of the following:

o ΔΔCq — relative normalized expression calculated using control samples and reference
targets.

o ΔCq — relative quantity of the target gene in a sample relative to a control sample.

You can view the data in the gene expression chart in one of three views. See Changing and
Annotating the Chart View on page 103 for more information.

n Spreadsheet — displays a spreadsheet of the gene expression data.

Tip: Right-click any chart or spreadsheet for options. Select View/Edit Plate from the Plate
Setup dropdown menu to open the Plate Editor and change well contents in the plate.

Tip: Select Sort from the right-click menu to rearrange the order of the Target and Sample
names in the chart.
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Normalized Gene Expression

To normalize data, use the measured expression level of one or more reference genes as a
normalization factor. Reference genes are targets that are not regulated in the biological system
being studied, such as actin,GAPDH, or tubulin.

To set up normalized gene expression (ΔΔCq) analysis

1. Open a data file (.pcrd extension).

2. Review the data in the Quantification tab of the Data Analysis window. Make adjustments to
the data, such as changing the threshold and the analysis mode.

3. Choose the Gene Expression tab.

4. In the Gene Expression tab, click Experiment Settings.

5. In the Experiment Settings dialog box, do the following:

a. Choose the Samples tab and select a control. When a control is assigned, CFX Maestro
software for Mac normalizes the relative quantities for all genes to the control quantity,
which is set to 1.

b. Choose the Target tab and select reference genes. Gene expression analysis requires
one reference among the targets in your samples.

6. Select Normalized Expression (ΔΔCq) if it is not already selected, and then view the
expression levels in the Gene Expression tab.

Relative Quantity

By definition, relative quantity (ΔCq) data are not normalized. This method is used to quantitate
samples that do not include any reference genes (targets). Typically, researchers are confident in
one of the following considerations when they set up their run:

n Each sample contains the same amount of template, possibly the same mass of RNA or cDNA
in each well.

n Any variance in the amount of biological sample loaded will be normalized after the run by
some method in the data analysis outside of the software. For example, a researcher might
choose to simply divide the relative quantity value by the normalizing factor, possibly the mass
of nucleic acid loaded for each sample, or the number of cells from which the nucleic acid was
isolated.

To run a Relative Quantity (ΔCq) analysis

u In the Gene Expression tab, select Relative Quantity (ΔCq) from the Mode dropdown list in the
right pane.

102 | CFXMaestro Software for Mac



Graphing

Tip: To compare results to data from other gene expression runs, open a new gene study
or add a data file to an existing gene study.

Changing and Annotating the Chart View
Using the charts toolbar menu commands and the data analysis chart tools, you can change the
chart view, annotate each chart, and change the chart display. The charts toolbar appears between
the chart and the data analysis spreadsheet at the bottom of the screen.

Chart Toolbar Tools

Tip: See Charts on page 46 for information about the chart tools that appear on the right side
of data analysis charts.

The toolbar below the charts provides quick access to annotation tools.

Table 21 lists the functions of the buttons in the charts toolbar.

Button Name Function

Bar chart Displays the relative expression of the targets.

Box and Whisker chart Displays data as quartile ranges (see Box and
Whisker Chart Calculations on page 183 for
calculation details).

Note: Available only if Analyze Using is set to
Biological Groups Only.

Dot Plot chart Displays the individual sample data points for each
target.
Note: Available only if Analyze Using is set to
Biological Groups Only.

Add Arrow Draws an arrow on the active chart.

Add Circle Draws a circle on the active chart

Table 21. Charts toolbar
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Button Name Function

Add Text Inserts a textbox on the active chart, in which you can
add text to identify items of interest in the chart.

Undo Removes or reverts the last annotation performed on
the active chart.

Redo Reverts the last Undo action performed on the active
chart.

Clear All Clears all annotations on the active chart.

Table 21. Charts toolbar, continued
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Sorting Target, Sample, and Biological Group Data

Note: This option is available on gene expression charts only.

By default, the Targets, Samples, and Biological Groups lists appear in alphabetical order. Use the
Sort dialog box to sort the display in reverse alpha order or to manually move a term to a different
position in the list.

To sort target, sample, and biological group data

1. From the chart tools, click Sort.

The Gene Expression Chart Sorting dialog box appears.

2. In the dialog box, click Z-A to sort the list in reverse alphabetical order.

3. To manually move a term, select it and click the appropriate button between the charts:

n Click the Up or Down arrow to move the selected term one position.

n Click the Up or Down bar arrow to move the selected term to the top or bottom of the list.

4. Click OK to save the changes and return to the Gene Expression tab.
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Changing the Target, Sample, and Biological Group Color Settings

Use the Color Settings dialog box to change the color of a target, sample, or biological group, or
remove the item from the graph.

To change the target color settings

1. In the right pane in the Gene Expression dialog box, verify that Sample appears in the X-Axis
dropdown list.

2. In the Chart Tools, select Color Settings.

The Color Settings dialog box appears.

3. To change the display color for a target, click its color in the Color column.

4. In the Color dialog box that appears, select a new color and click OK.

5. To remove a target from the gene expression graph, clear its checkbox in the Show Chart
column.

Tip: To clear all targets, clear Show Chart in the column head.

6. (Optional) By default, the bars appear in solid colors. To display the bars in gradient colors,
clear Use Solid Colors.

7. Click OK to save the changes and return to the Gene Expression tab.
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To change the sample or biological group color settings

1. In the right pane on the Gene Expression dialog box, verify that Target appears in the X-Axis
dropdown list.

2. Perform the steps in To change the target color settings on page 106.

Changing the Chart View

To change the current chart view

u Select the toolbar menu command for the target view.

Note: The Gene Expression tab always opens displaying the data in default Bar Chart view.
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Excluding Outlier Data Points

In the Dot Plot chart, you can easily view and exclude outliers from your analysis.

To exclude outlier data points

u In the Dot Plot chart, right-click the target outlier and select Exclude Well from Analysis.

The data point is removed from the Dot Plot chart and the well changes to gray in the Well Selector
in the Quantification tab.

To include an excluded outlier data point

u In the Quantification tab, right-click the well in the Well Selector and select Well > Include in
Analysis.

Viewing Data Point Details

To view data point details

u In the Box and Whisker plot or the Dot Plot, pause your cursor on an individual data point.

A tooltip displays, showing the sample name and its expression (relative quantity or normalized
expression, depending on the selected mode).

Annotating Charts

You can add arrows, circles, and text to each bar chart view to clearly communicate data. The
annotations are saved with the bar chart and appear in the exported and printed file. However,
annotations made to one chart view are not added to the other chart views.

To draw an arrow or circle on the chart

1. In the bar chart toolbar, click the specific tool.

2. Click in the bar chart and drag your cursor across the chart as necessary.

To add text to the chart

1. In the bar chart toolbar, click Add Text.

2. Click in the bar chart. A text box appears at that location.
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3. Add text in the text box.

4. Click anywhere on the chart to exit the text box.

Tip: Press Enter to add multiple lines to the text box.

To move an annotation

1. Hover your cursor over the annotation. The icon changes to a pointing finger and the
annotation border is highlighted.

2. Click the annotation and drag it to another position.

3. Release the annotation to secure its position.

To undo an annotation

u Click Undo.

The most recently added annotation is removed.

Tip: You can undo the ten most recent annotations, one at a time.

To redo an annotation

u Click Redo.

The most recently removed annotation returns.

Tip: You can redo the ten most recent annotations, one at a time.

To delete an annotation

u Right-click the annotation and select Delete.

Adjusting Gene Expression Data
After selecting your analysis mode, adjust the data you view in the Gene Expression tab by
changing the settings options to the right of the chart.

Graph Data

Set the y-axis value to Linear scale to enable graph data options. Graph data options allow you to
present the data in the graph with one of these options:

n Relative to control — graph the data with the axis scaled from 0 to 1. If you assign a control in
your run, select this option to quickly visualize upregulation and downregulation of the target.

n Relative to zero — graph the data with the origin at zero.

Tip: You set the graph data options in the Gene Expression tab in the User Preferences dialog box.
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Analyze Using

Use the dropdown menu to select how data is analyzed and plotted. The options are:

n Samples Only — data are analyzed and plotted on a per sample basis.

n Biological Groups Only — data are analyzed and plotted for biological groups. The expression
displayed for the biological group is the geometric mean of the samples in that group.

n Sample Biological Group — data are analyzed and plotted on a per sample basis with the
biological group appended after the sample name. The P-values shown are calculated based
on the biological group.

n Biological Group Sample — data are analyzed and plotted on a per sample basis with the
biological group prepended before the sample name. The P-values shown are calculated
based on the biological group.

Control

Use the Control dropdown menu to select a sample or biological group (depending on your
Analyze Using selection) that will be used to normalize the Relative Quantity:

n If you selected Samples Only, the Control dropdown list displays all samples in the study.

n If you selected Biological Groups Only, Sample Biological Group, or Biological Group Sample,
the Control dropdown list displays all biological groups in the study.

Note: The selected biological group is also used to calculate the P-value.

Tip:When analyzing by samples only or biological groups only, setting Control to None
enables the Scaling option, in which you can scale the data to Average, Lowest, Highest, or
Unscaled. See Scaling Options on page 111 for more information.

Annotate P-Values and P-Value Threshold

When Annotate P-Values is selected, the software displays an asterisk (*) on the bar chart above a
target if its P-value is below the selected threshold. The software automatically calculates the P-
value by comparing the sample’s expression level to the selected control sample’s expression
level using a standard t-test. The P-value threshold range is 0.000—1.000.

X-Axis Options

The x-axis option allows you to select the x-axis data of the Gene Expression chart:

n Target — graphs the target names on the x-axis.

n Sample — graphs the sample names on the x-axis.
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Y-Axis Options

The y-axis option allows you to show the Gene Expression chart in one of these three scales:

n Linear — select this option to show a linear scale.

Tip: Setting the y-axis to Linear enables the Graph Data dropdown list, from which you
can choose to graph data relative to control or relative to zero.

n Log 2 — select this option to evaluate samples across a large dynamic range.

n Log 10 — select this option to evaluate samples across a very large dynamic range.

Scaling Options

Select Normalized Gene Expression (ΔΔCq) and set the Control to None (for either Sample or
Biological Group) to enable the scaling options in the Gene Expression chart. Select one of these
scaling options to calculate and present your data in a manner that best suits your run design:

n Unscaled — presents the unscaled normalized gene expression.

n Highest — scales the normalized gene expression for each target by dividing the expression
level of each sample by the highest level of expression in all the samples.

This scaling option uses the scaled-to-highest formula.

n Lowest — scales the normalized gene expression for each target by dividing the expression
level of each sample by the lowest level of expression in all the samples.

This scaling option uses the scaled-to-lowest formula.

n Average — scales the normalized gene expression for each target by dividing the expression
level of each sample by the geometric mean of the expression levels for all the samples.

This scaling option uses the scaled-to-average formula.

Error Bar

Select an option for the type of error calculations (error bars) in the Gene Expression chart:

n Options if Analyze Using is set to Samples Only, Sample Biological Group, or Biological Group
Samples:

o Standard error of the mean (default)

o Standard deviation

n Options if Analyze Using is set to Biological Groups Only:

o Confidence interval (default)
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o Standard error of the mean (Log2 expression)

o Standard deviation (Log2 expression)

Chart Error Bar Multiplier

Select a multiplier for the error bars in the Gene Expression chart. Select one of these integers:
+/- 1 (default), 2, or 3. The type of multiplier changes when you select the error bar:

n SEMs for standard error of the mean

n Std Devs for standard deviations

Experiment Settings
Tip: This dialog box is also available in the Plate Editor. For more information, see Changing
Experiment Settings on page 160.

In the Experiment Settings dialog box, you can view or change the list of targets and samples or
biological groups, select reference genes, select controls, or set the Gene Expression Analysis
group to be analyzed if biological groups have been added to the wells.

To open the Experiment Settings dialog box

u In the Graphing tab, click Experiment Settings at the bottom of the right pane.

The Experiment Settings dialog box appears displaying the Targets tab.
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To adjust Targets settings

u In the Targets tab, do any of the following:

n To select a target as a reference for gene expression data analysis, select its name in the
Reference column.

n To change the target’s color, click its cell in the Color column and change the color in the
Color dialog box that appears.

The color change appears in the Gene Expression charts.

n To use a previously determined efficiency value, clear the target’s checkbox in the Auto
Efficiency column and enter a number for the efficiency percentage of a target.

The software calculates the relative efficiency for a target using Auto Efficiency if the data
for a target include a standard curve.

To adjust the Sample or Biological Group settings

u In the Samples and Biological Groups tab, do any of the following:

n To select a sample as a control for gene expression data analysis, select its name in the
Control column.

n To select a biological group as a control for gene expression data analysis, select its
name in the Control column.

n To change the sample or biological group’s color, click its cell in the Color column and
change the color in the Color dialog box that appears.

The color change appears in the Gene Expression charts.

n To display the sample or biological group in the Gene Expression charts, select it in the
Show Chart column.

n To remove the sample or biological group from the Gene Expression charts, clear it in the
Show Chart column.

Tip: The sample or biological group’s data remain in the Results table.

To exclude a sample type from analysis calculations

u Select its checkbox at the bottom of the Experiment Settings dialog box.

Note: This excludes controls and/or standards from gene expression analysis.
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Right-Click Menu Options
Right-click on the gene expression chart to select the items shown in Table 22.

Item Function

Copy Copies the chart to a clipboard.

Save Image As Saves the chart as an image file. Set the resolution and dimensions
of the image and then select the file type (PNG, JPG, or BMP).

Page Setup Selects a page setup for printing.

Print Prints the chart.

Set Scale to Default Show All displays all of the data in the bar chart. Scroll Bar
displays a scroll bar if there are too many samples to display in the
chart frame while maintaining a minimum bar width.

Chart Settings Opens the Chart Settings window to adjust the graph.

Sort Sorts the order of samples or targets that appear on the chart x-axis.

Color Settings Opens the Color Settings window, from which you can change the
color of targets or samples in the chart.

User Corrected Std Devs Calculates the error bars using the corrected standard deviation
formula.

Use Solid Bar Colors Displays solid bars in the chart.

X–Axis Labels Displays x-axis labels horizontally or angled.

Table 22. Gene expression right-click menu items
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Data Spreadsheet
Table 23 defines the data displayed in the Gene Expression Data Table.

Note: The values in the table are calculated based on the graph type and preferences
selected in the right-hand pane.

Information Description

Target Target name (amplified gene) selected in the Experiment Settings
window.

Sample

Biological Group

Sample Biological Group

Biological Group Sample

Sample and/or biological group name selected in the Experiment
Settings window.

Control Control name selected in the Experiment Settings window. When
Analyze Using is set to Samples Only, Control is the sample
selected in the Experiment Settings window. When either Biological
Groups Only, Sample Biological Group, or Biological Group
Sample is selected, control is the biological group selected in the
Experiment Settings window.

Relative Quantity or
Expression

Relative Quantity (ΔCq) or Normalized Gene Expression (ΔΔCq),
depending on the selected mode.

Relative Quantity or
Expression SEM (or SD)

Standard error of the mean (SEM) or standard deviation (SD) of the
relative quantity or normalized expression, depending on the
selected option. Available only if Analyze Using is set to Samples
Only, Sample Biological Group, or Biological Group Sample.

Corrected Relative Quantity or
Expression SEM (or SD)

Corrected value calculation for SEM or SD of the relative quantity
or normalized expression, depending on the selected option.
Available only if Analyze Using is set to Samples Only, Sample
Biological Group, or Biological Group Sample.

Mean Cq Mean of the quantification cycle (not displayed if Analyze Using is
set to Biological Groups Only).

Table 23. Description of information in the spreadsheet on the Graphing tab
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Information Description

Cq SEM (or SD) SEM or SD of the quantification cycle, depending on the selected
option (not displayed if Analyze Using is set to Biological Groups
Only).

P-Value A measure of statistical significance derived from the student's
t-test. Refer to P-Value on page 171 for additional information.

Note: The P-values reported in the bar chart are based on the
selected control. You can choose to annotate the chart with P-
values falling below a user-specified threshold.

Relative Quantity n% CI Low
or
Expression n% CI Low

Confidence interval (CI) lower limit, where the % value is based on
the P-value threshold. Selected Mode determines whether it is
relative quantity or expression. Available only if Analyze Using is
set to Biological Groups Only and Error Bar is set to Confidence
Interval.

Relative Quantity n% CI High
or
Expression n% CI High

Confidence interval (CI) upper limit, where the % value is based on
the P-value threshold. Selected Mode determines whether it is
relative quantity or expression. Available only if Analyze Using is
set to Biological Groups Only and Error Bar is set to Confidence
Interval.

RQ Lower Error Bar
or
Exp. Lower Error Bar

Value of lower error bar when Error Bar is set to Standard Deviation
(lg) or Standard Error of the Mean(lg). Selected Mode determines
whether it is relative quantity (RQ) or expression (Exp.). Available
only if Analyze Using is set to Biological Groups Only.

RQ Upper Error Bar
or
Exp. Upper Error Bar

Value of upper error bar when Error Bar is set to Standard
Deviation(lg) or Standard Error of the Mean(lg). Selected Mode
determines whether it is relative quantity (RQ) or expression (Exp.).
Available only if Analyze Using is set to Biological Groups Only.
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Show Details Option
Table 24 defines the data displayed when Show Details is selected from the right-click menu of the
bar chart spreadsheet.

Information Description

Data Set Fluorescence data from one fluorophore in the data file

Relative Quantity Calculated relative quantity of samples

Relative Quantity SD Standard deviation of the relative quantity calculation

Corrected Relative Quantity SD Calculated standard deviation of the corrected relative quantity

Relative Quantity SEM Standard error of the mean of the relative quantity calculation

Corrected Relative Quantity
SEM

Calculated standard error of the mean of the corrected relative
quantity

Relative Quantity(lg) Log2 of the relative quantity that is used for statistical analysis

SD RQ(lg) Standard deviation of the relative quantity (log2)

SEM Expression(lg) Standard error of the mean of the expression (log2)

Unscaled Expression Calculated unscaled expression

Unscaled Expression SD Calculated standard deviation of the unscaled expression

Corrected Unscaled
Expression SD

Calculated standard deviation of the corrected unscaled expression

Unscaled Expression SEM Calculated standard error of the mean of the unscaled expression

Corrected Unscaled
Expression SEM

Calculated standard error of the mean of the corrected unscaled
expression

Unscaled Expression(lg) Log2 of the unscaled expression

SD Unscaled Expression(lg) Standard deviation of the unscaled expression (log2)

SEM Unscaled Expression(lg) Standard error of the mean of the unscaled expression (log2)

Expression Normalized gene expression

Table 24. Information in the bar chart spreadsheet with Show Details selected
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Information Description

Corrected Expression SD Calculated standard deviation

Expression SEM Standard error of the mean

Corrected Expression SEM Calculated standard error of the mean

Expression(lg) Log2 of the expression (normalized expression) that is used for
statistical analysis

SD Expression(lg) Standard deviation of the expression (log2)

SEM Expression(lg) Standard error of the mean of the expression (log2)

Sample # Number of samples in the biological group

Mean Cq Mean of the quantification cycle (not displayed when Analyze Using
is set to Biological Groups Only)

Cq SD Standard deviation of the quantification cycle (not displayed when
Analyze Using is set to Biological Groups Only)

Cq SEM Standard error of the mean of the quantification cycle (not displayed
when Analyze Using is set to Biological Groups Only)

P-Value A measure of statistical significance derived from the student's
t-test. Refer to P-Value on page 171 for additional information.

Note: The P-values reported in the bar chart are based on the
selected control. You can choose to annotate the chart with P-
values falling below a user-specified threshold.

Table 24. Information in the bar chart spreadsheet with Show Details selected, continued
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Clustergram
The clustergram displays the data in a hierarchy based on the degree of similarity of expression for
different targets and samples.

Note: You must choose a reference target to display any of the data plots other than relative
expression for bar charts.

The clustergram image depicts relative expression of a sample or target as follows:

n Upregulation (red) — higher expression

n Downregulation (green or blue) — lower expression

n No regulation (black)

n No value calculated (black with a white X)

The lighter the shade of color, the greater the relative expression difference. If no normalized Cq
value can be calculated, the square will be black with a white X.

On the outer edges of the data plot is a dendrogram, which indicates the clustering hierarchy.
Targets or samples that have similar expression patterns will have adjacent branches while those
with dissimilar patterns will be more distant.

Settings
You can set the following options:

n Cluster By — choose from Targets, Samples, Both, or None.

n Size — adjusts the image size and changes the degree of chart magnification for easier
visualization.

n Split Out Replicates — displays values for the individual replicates.

Tip: You can change the color scheme for clustergram, scatter plot, heat map, and volcano
plot from the default Red/Green to Red/Blue by selecting this option from the right-click menu
on any of these charts.

Right-Click Menu Options
Right-click menu options for the clustergram are the same as those for the bar chart. See Table 22
on page 114 for available options. In addition, select Color Scheme to change the downregulation
expression from the default Red/Green to Red/Blue on the chart.

Data Spreadsheet
The spreadsheet displays values for the target, sample, and normalized expression.
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Scatter Plot
The scatter plot displays the normalized expression of targets for a control versus an experimental
sample.

The lines in the plot indicate the fold change threshold. Data points between the lines indicate that
the difference in expression for that target (gene) is negligible between the samples. Data points
outside the lines exceed the fold change threshold and might be of interest.

The plot image shows the following changes in target expression based on the fold change
threshold:

n Upregulation (red circle) — relatively higher expression

n Downregulation (green or blue circle) — relatively lower expression

n No change (black circle)

Click and drag either threshold line to adjust the fold change threshold value.

Settings
You can set the following options:

n Control Sample

n Experimental Sample

n Fold Change Threshold

As you increase or decrease the fold change value, the threshold lines in the plot move
accordingly.

Right-Click Menu Options
Right-click menu options for the scatter plot are the same as those for the bar chart. See Table 22
on page 114 for available options. In addition, select Symbol to change the symbol used on the
plot from the default circle to one of the following:

n Triangle

n Cross

n Square

n Diamond
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Data Spreadsheet
The spreadsheet displays the values for the target and normalized expression for control and
experimental samples. It also indicates whether targets are up- or downregulated compared to the
target regulation.
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Volcano Plot
The volcano plot displays the relative expression of targets in an experimental biological group
compared to a control and indicates the degree of significance based on P-value.

The lines in the plot indicate the fold change threshold. Data points between the lines indicate that
the difference in expression for that target (gene) is negligible. Data points outside the lines
exceed the fold change threshold and might be of interest.

Note: In the Charts tab, if you choose to analyze using only samples, the Volcano Plot tab is
grayed out (not usable). Ensure that you have selected a control biological group in the
Experiment Settings dialog box and that your analysis includes biological groups in the Charts
tab.

The plot displays the following fold changes based on the threshold setting:

n Upregulation (red circle) — higher expression

n Downregulation (green or blue circle) — lower expression

n No change (black circle)

Click and drag either threshold line to adjust the fold change threshold value.

Settings
You can set the following options:

n Control Biological Group

n Experimental Biological Group

n Fold Change Threshold

n P-Value Threshold

As you increase or decrease Fold Change Threshold or P-Value Threshold values, the
threshold lines in the plot move accordingly.

Right-Click Menu Options
Right-click menu options for the volcano plot are the same as those for the bar chart. See Table 22
on page 114 for available options. In addition, select Symbol to change the symbol used on the
plot from the default circle to one of the following:

n Triangle

n Cross
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n Square

n Diamond

Data Spreadsheet
The spreadsheet displays the values for the target, biological group, fold change, and P-value. It
also indicates whether the P-value exceeds its threshold (significant P-value) and the target is up-
or downregulated compared to the target regulation.
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Heat Map
The heat map presents a visual depiction of the regulation of targets for an experimental sample
compared to a control sample based on relative normalized expression and its location on a plate.

Note: This feature should be used only with singleplex PCR experiments.

A legend below the heat map displays the range of normalized expression, which corresponds to

n Upregulation (red) — higher expression

n Downregulation (green or blue) — lower expression

n No change (black)

The lighter the shade of color, the greater the relative normalized expression difference. If no
normalized expression value can be calculated, the square appears black with a white X.

Settings
You can set the following options:

n Control Sample

n Experimental Sample

n Size — use the slider to adjust the image size to change the degree of chart magnification

n Split Out Replicates — displays values for the individual replicates

Right-Click Menu Options
Right-click menu options for the heat map are the same as those for the bar chart. See Table 22 on
page 114 for available options. In addition, select Color Scheme to change the downregulation
expression from the default Red/Green to Red/Blue on the chart.

Data Spreadsheet
The spreadsheet displays the values for the target, sample, and fold change.
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ANOVA
The ANOVA tab displays the results of one-way analysis of variance (ANOVA). ANOVA tests the
hypothesis that the mean target expression between any two biological groups is equal. The null
hypothesis states that the mean expression of all biological groups is equal, while the alternative
hypothesis states that at least one biological groups is different.

CFX Maestro software for Mac also performs a pairwise comparison of the mean expression
between biological groups via Tukey's HSD test.

CFX Maestro software for Mac uses the following R packages to perform ANOVA and to determine
the Tukey's HSD post hoc results:

n car (companion to applied regression)

n lsmeans (least-square means)

Settings
You can set the P-value threshold for one-way ANOVA.

Calculating ANOVA

When you first select the ANOVA tab, click "Not current. Click to recalculate" to calculate one-way
ANOVA. If successful, the data appear in the ANOVA tab in the Results table in the lower pane
(see Results Table on page 126).

Note: If ANOVA cannot be performed, the software automatically displays the Errors tab, which
provides possible reasons for errors reported in the ANOVA analysis.

To recalculate ANOVA

u In the ANOVA tab, click "Not current. Click to recalculate."

The next time you open the file and select the ANOVA tab, CFX Maestro recalculates ANOVA using
the saved settings.

Exporting R Scripts

After calculating ANOVA, you can export the results and the R script, and open the .r file in a
stand-alone R application. The .r script requires the car and lsmeans packages. The exported .r
script contains the code for the required packages and will install them if they are not installed in
the stand-alone R application.
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To export R scripts

u In the ANOVA tab, click Export R Script and provide a name and location for the .r file in the
Save As dialog box that appears.

Results Table
Data from ANOVA appear in tabs in the results table. Table 25 defines the columns for each tab in
the table.

Tab Heading Description

ANOVA

Target The gene/region of interest that will be amplified by PCR

df The number of values in the final calculation that are
allowed to vary

P-Value
ANOVA

The ANOVA P-value calculated for the target. This
P-value is not corrected for multiple testing.

Contrast The two biological groups that are being compared

Ratio The ratio of the expression for the two biological groups
compared. The numerator is the first biological group in
Contrast and the denominator is the second biological
group in Contrast.

P-Value BH The ANOVA P-value after Benjamini-Hochberg
correction for false discovery rate.

Note: This column is displayed only if the
experiment contains multiple genes.

Lower
Bound (X%)

The lowest limit value associated with the confidence
interval that, at a given percent probability, the
confidence interval will contain the true population mean

Upper
Bound (Y%)

The highest limit value associated with the confidence
interval that, at a given percent probability, the
confidence interval will contain the true population mean

Table 25. ANOVA Results table column descriptions
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Tab Heading Description

P-Value
Tukey

The P-value derived from Tukey's HSD test, indicating
the significance of the difference in expression between
the two biological groups tested. This P-value is
corrected for the family-wise error rate.

Significant The significance of the P-value for these conditions:

n For multiple-gene tests, if P-Value BH or P-Value
Tukey shows significance (P-Value BH or P-Value
Tukey is less than 0.05) the Significant column for the
associate ANOVA row displays Yes; otherwise, it
displays No.

n For single-gene tests, if P-Value ANOVA shows
significance (P-Value ANOVA < 0.05) the Significant
column for the associate ANOVA row displays Yes;
otherwise, it displays No.

Shapiro-Wilk
Normality Test

The Shapiro-Wilk test is used to determine the
likelihood that the expression values of the samples in a
biological group are obtained from a normally distributed
population. The null hypothesis for this test states that
the population of expression values for the biological
group is normally distributed. A smaller P-value
indicates that expression values are less likely to come
from a normal distribution.

Target The gene/region of interest that will be amplified by PCR

Biological
Groups

The set of samples for which the normality of the
expression values is tested

Count The number of samples in the biological group (must be
between 3 and 5,000)

Tip: Use this column to view balanced vs.
unbalanced datasets.

P-Value The probability that the population of expression values
are normally distributed. Calculated from the W-value

Table 25. ANOVA Results table column descriptions, continued

User Guide | 127



Chapter 7 Gene Expression Analysis

Tab Heading Description

Normal Indicates whether the expression of the target is
normally distributed among the samples in the specified
biological group based on the P-value exceeding the
user-defined threshold:

"Yes" if P-Value > P-Value Threshold

"No" if P-Value < P-Value Threshold

Error Errors encountered while performing the Shapiro-Wilk
test

Errors

Message The reason for errors reported in the ANOVA analysis

Table 25. ANOVA Results table column descriptions, continued

Right-Click Menu Options
Right-click menu options for the ANOVA results chart are the same as those for the bar chart. See
Table 22 on page 114 for available options.
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Gene Study
Create a gene study to compare gene expression data from one or more real-time PCR
experiments using an inter-run calibrator to normalize between the experiments. Create a gene
study by adding data from one or more data files (.pcrd extension) to the gene study. The software
groups them into a single file (.mgxd extension).

Note: The maximum number of samples you can analyze in a gene study is limited by the size
of the computer’s RAM and virtual memory.

Inter-Run Calibration
Inter-run calibration is automatically attempted in every gene study for each target to normalize
inter-run variations between targets assayed in separate real-time PCR runs (that is, different .pcrd
files generated from different plates).

For the software to recognize a sample as an inter-run calibrator, it must share the same target
name, sample name, and, if used, biological set name across every plate being compared.

Note: At least one inter-run calibrator sample must be present in the gene study for inter-run
calibration to occur. Targets without appropriate inter-run calibrator samples will be processed
without correction in the gene study (not recommended).

Inter-run calibrators can be applied in two ways:

n Per target — different PCR primers can have different efficiencies. By default the inter-run
calibrator is applied to all of the wells on the same plate that have the same target name, for
example the Cq generated with the same assay.

n Entire study — one inter-run calibrator is selected by the user and applied to the entire gene
study.
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Gene Study Dialog Box

The Gene Study dialog box includes two tabs:

n Study Setup tab — manages the runs in the gene study.

Important: Adding or removing data files in a gene study does not change the data in the
original file.

n Study Analysis tab — displays the gene expression data for the combined runs.

Study Setup Tab
Table 26 defines the data that appear in the Study Setup tab.

Column Title Description

File Name Name of the run data file (.pcrd extension)

File Folder Directory that stores the data file for each run in the gene study

Date Created Date the run data were collected

Well Group Name Name of the well group that was selected when the file was added to
the gene study

Tip: To analyze one well group in the gene study, you must select
that well group in the Data Analysis window before importing the
data file into the gene study.

Table 26. Study Setup tab in the Gene Study dialog box

130 | CFXMaestro Software for Mac



Gene Study

Column Title Description

Step Protocol step that includes the plate read to collect real-time PCR data

Run Type Either user-defined or PrimePCR™ run

Protocol Edited If selected, indicates that the protocol used for a PrimePCR run was
edited

View Plate Opens a plate map of the plate with the data in each of the runs
included in the Gene Study

Table 26. Study Setup tab in the Gene Study dialog box, continued

Preparing a Gene Study
To prepare a gene study

1. Before importing data into a gene study, do the following in the Data Analysis window:

n Verify that samples containing the same content have the same name. In a gene study,
the software assumes that wells with the same Target or Sample name contain the same
samples.

n Adjust the baseline and threshold (Cq) in the Quantification tab to optimize the data in
each run.

n Select the well group you want to include in the gene study.

In order to show data from one well group in the gene study, that group must be selected
before importing the data file.

The Study Setup tab shows a list of all the runs in the gene study.

2. In the Gene Study dialog box, choose the Study Setup tab.

3. Click Add Data Files to select a file from a browser window. To quickly add runs to a gene
study, drag the data files (.pcrd extension) into the Study Setup dialog box.

4. CFX Maestro software for Mac automatically performs the gene study analysis as you add data
files. Choose the Study Analysis tab to view the results.

Tor remove runs from the gene study

u Select one or more files in the list and click Remove.

To add notes about the gene study

u Enter notes about the files and analysis in the Notes text box.
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Study Analysis Tab
The Study Analysis tab displays the data from all runs in the gene study. The gene expression data
analysis options are the same as those for a single data file with the following exceptions:

n For bar charts, inter-run calibration values (if calculated) appear when you click Inter-run
Calibration.

Note: Only the following sample types can be used as an inter-run calibrator:

o Unknown

o Standard

o Positive Control

Negative control, no template control (NTC), and no reverse transcriptase control (NRT)
sample types cannot be used as an inter-run calibrator.

n For heat maps, if the same targets are in the same location on multiple plates but with different
samples, use the dropdown menu to select a particular plate for analysis.

n The Reference Gene Selection tool identifies the tested reference genes and categorizes
them as Ideal, Acceptable, or Unstable based on their stability:

o Ideal reference genes are stable and represent minimal variations across the tested
samples.

o Acceptable reference genes are not ideally stable and represent moderate variation
across tested samples. Use these reference genes in analysis if no Ideal reference genes
are present.

o Unstable reference genes represent excessive variation across tested samples. It is
recommended that these genes be excluded from analyses.

n The PrimePCR Controls tool displays the results of the tested samples in a table:

o The Summary tab displays a summary of all tested samples. Samples that passed all of
the control assays appear in green. Samples that failed one or more of the control assays
appear in yellow.

o The PCR tab displays the results of the positive PCR control assay. This assay detects
inhibition or experimental problems that affect gene expression.

o The RT tab displays the results of the reverse transcription control assay. This assay
qualitatively evaluates RT performance and identifies samples where RT performance is
likely to compromise gene expression.
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o The gDNA tab displays the results of the DNA contamination control assay. This assay
determines whether genomic DNA (gDNA) is present in a sample at a level that might
affect qPCR results.

o The RQ tab displays the results of the RNA quality assays (RQ1 and RQ2). These assays
qualitatively assess whether RNA integrity might adversely affect gene expression.

Gene Study Reports
Use the Gene Study Report dialog box to arrange the gene study data into a report. Table 27 lists
all the options available for a gene study report.

Category Option Description

Header

Title, subtitle, and logo for the report

Report Information Date, user name, data file name, data file path,
and the selected well group

Gene Study File List List of all the data files in the Gene Study

Notes Notes about the data report

Study Analysis: Bar Chart

Analysis Settings List of the selected analysis parameters

Chart Gene Expression bar chart showing the data

Target Names List of targets in the Gene Study

Sample Names List of samples in the Gene Study

Data Spreadsheet that shows the data

Target Stability Target stability data

Inter-run Calibration Inter-run calibration data

Box-and-Whisker Chart Gene Expression box-and-whisker chart

Dot-Plot Chart Gene Expression dot plot chart

Study Analysis: Clustergram, Scatter Plot, Volcano Plot, and Heat Map

Table 27. Categories for a Gene Study report
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Category Option Description

Analysis Settings Settings for each chart type

Chart Gene Expression chart showing the data

Data Spreadsheet listing the data in each target

Study Analysis: ANOVA Data

ANOVA Settings P-value threshold used in the analysis

ANOVA Results Table of results from ANOVA and Tukey's HSD
post-hoc analysis

Shapiro-Wilk Normality
Test

Biological group, count, P-value, and any errors
that occur for each target in the analysis

ANOVA Errors Errors identified during ANOVA calculations

Table 27. Categories for a Gene Study report, continued
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Creating a Gene Study Report
To create a gene study report

1. Adjust the gene study report data and charts as needed before creating a report.

2. Select Tools > Reports in the Gene Study menu to open the Report dialog box.

3. Choose the options you want to include in the report. The report opens with default options
selected. Select or clear the checkboxes to change whole categories or individual options
within a category.

The section Gene Study Reports that follows lists the available options to display.

4. Change the order of categories and items in a report. Drag the options to the required position.
Items can be reordered only within the categories to which they belong.

5. Click Update Report to update the Report Preview with any changes.

6. Print or save the report. Click the Print Report button in the toolbar to print the current report.
Select File > Save to save the report in PDF (Adobe Acrobat Reader file) format and select a
location in which to save the file. Select File > Save As to save the report with a new name or
in a new location.

7. (Optional) Create a report template with the information you want. To save the current report
settings in a template, select Template > Save or Save As. Then load the report template the
next time you want to make a new report.
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A plate file contains information about run parameters such as scan mode, fluorophores, and well
contents. After the run, CFX Maestro™ software for Mac links the well contents to the fluorescence
data collected during the run and applies the appropriate analysis in the Data Analysis window.
For example, wells loaded with standard sample type are used to generate a standard curve.

CFX Maestro software for Mac provides two options for creating plates: The Plate Editor for real-
time PCR runs and the Setup Wizard for normalized gene expression analysis.

The Plate Editor includes the following features:

n Standard fluorophores and sample types to assign to plate wells

n Ability to set reference target and control sample for gene expression analysis

n Ability to edit plate setup before, during, or after a run

n Ability to save plate files for reuse

n Ability to print the plate file to a default printer

The Setup Wizard guides you through creating a plate layout for normalized gene expression
analysis. You can use the Setup Wizard before, during, or after a run.
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Plate Editor Window
You use the Plate Editor to create custom plates or modify existing plates.

File Menu Commands
Save— saves the plate data file in the location specified in the File tab in the User Preferences
dialog box. See Changing the Default File Settings on page 23 for more information.

Save As— saves the open plate data file with a new name that you supply.

Print— prints the open plate data file.

Close— closes the Plate Editor.

Edit Menu Commands
Undo— reverts a change to a plate file until the plate file is saved.

Redo— reverses the most recent Undo action unless the plate file has been saved.
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Settings Menu Commands
Plate Size— opens a dialog box from which you can select a plate size for the run.

Note: The plate size must be the same as the block size on the instrument on which the
run is performed. Choose 384-well for the CFX384 Touch™ system or 96-well for the
CFX96 Touch™, CFX96 Touch™ Deep Well, or CFX Connect™ system.

Plate Type— opens a dialog box from you can choose the type of wells in the plate that holds your
samples, including BR White and BR Clear. For accurate data analysis, the plate type selected
must be the same as the plate type used in the run.

Number Convention— opens a dialog box from which you can choose how to display units. The
default is to display units in scientific notation.

Units— opens a dialog box from which you can choose the units to show in the spreadsheets
when performing quantification of unknowns vs. a standard curve.

Editing Tools Menu Commands
SetupWizard— opens the Setup Wizard, in which you can define layout and analysis parameters
for the current plate. You can use the Setup Wizard before, during, or after a run has completed.

Spreadsheet View/Importer— opens the View dialog box, which displays the plate layout as a
template in spreadsheet format. You can use this dialog box to export or import plate template data
in .csv format.

Flip Plate— flips the plate contents 180o.

Toolbar Commands

— reverts a change to a plate. CFX Maestro software for Mac supports up to undo
actions.

— reverses the most recent Undo action. CFX Maestro software for Mac supports up to
ten redo actions.

— saves the current plate file.

— displays a dropdown list from which you can increase or decrease the
magnification of the plate view.
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— displays a dropdown list from which you can select a scan
mode, which instructs the instrument from which channels to collect fluorescence data during a
run.

— opens the Well Groups Manager, which you can use to create well groups for
the current plate.

— displays a dialog box in which you can choose the colors and symbols for the
amplification traces.

— opens the View dialog box, which displays the plate layout as a
template in spreadsheet format. You can use this dialog box to export or import plate template data
in .csv format.

— opens the Setup Wizard, in which you can define the layout and analysis
parameters for the current plate. You can use the Setup Wizard before, during, or after a run.

— opens the Plate tab in the User Preferences dialog box, in which you can
define plate layout parameters and create or delete target, sample, and biological group names.
Changes that you make in the Plate tab are available the next time you open the Plate Editor.

— displays the necessary steps for setting up a plate and loading the wells.
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Creating a Plate File Using the Plate Editor
Using the Plate Editor, you can create custom plate files. You can also edit and save previously
saved plate files or sample plate files shipped with CFX Maestro software for Mac.

To create a new plate file, perform the following:

n Open a plate file in the Plate Editor.

n Select the plate type.

Note: The plate type for the plate file must be the same as the plate in the reaction
module.

n Select the scan mode to use in the protocol.

n Select the fluorophores to use in the plate.

n Select the sample type, targets, and samples.

n Select technical replicates, if appropriate.

n Save the plate layout.

Tip: To create a new plate from previously saved or sample plate files, see Opening an
Existing Plate File in the Plate Editor on page 142.

Opening a New Plate File in the Plate Editor
To open a new plate file

u In the Home window, do one of the following:

n Click Plate in the Create New pane.

n Select File > New Plate.

The Plate Editor window opens displaying the default plate file for the selected instrument.

Tip: For information about setting your default plate file, see Changing the Default File
Settings on page 23.
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Opening an Existing Plate File in the Plate Editor
CFX Maestro software for Mac provides sample plate files that you can edit and save as a new
plate. You can also create a new plate file from a previously saved plate file.

To open a sample plate file

1. In the Home window, select File > Open > Plate.

The Finder opens to the location of the CFX Maestro Sample files folder.

2. Open the Sample files folder, and then open the Plates folder.

3. Select the plate of choice and click Open.

The sample plate file opens in the Plate Editor window.

4. Select File > Save As and save the plate file with a new name or in a new folder.

To open a previously saved plate file

1. In the Home window, do one of the following:

n Click Plate in the Open pane, navigate to and open the target plate.

n Select File > Open > Plate, navigate to and select the target plate, and click Open.

The target plate opens in the Plate Editor window.

2. Select File > Save As and save the plate file with a new name or in a new folder.
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Setting Up a New Plate File
Tip: If your plate file includes the required parameters (for example, if you are editing a sample
or existing plate file) you can skip this section. Proceed to Assigning Optional Parameters to
the Plate File on page 149.

New plate files require the following parameters:

n Plate size

n Plate type

n Scan mode

n One fluorophore (dye)

n One sample type

Selecting the Plate Size and Type

Important: You must select a plate size during plate setup. You cannot change the plate size
during or after a run.

The software applies the plate size and type to all the wells during the run. Ensure that the plate
size selected is the same as the plate you will use in the run.

Bio-Rad’s CFX96 Touch, CFX96 Touch Deep Well, CFX Connect, and CFX384 Touch instruments
are factory-calibrated for many fluorescent dye and plate combinations. Calibration is specific to
the instrument, dye, and plate type. Ensure that the fluorophore you plan to use is calibrated for the
plate type you select.

Selecting Scan Mode

The CFX96 Touch and CFX96 Touch Deep Well systems excite and detect fluorophores in six
channels. The CFX Connect system excites and detects fluorophores in three channels. The
CFX384 Touch system excites and detects fluorophores in five channels. All systems use multiple
data acquisition scan modes to collect fluorescence data during a run.

CFX Maestro software for Mac provides three scan modes:

n All Channels

o Scans channels 1 through 5 on the CFX96 Touch and CFX96 Touch Deep Well systems

o Scans channels 1 and 2 on the CFX Connect system

o Scans channels 1 through 4 on the CFX384 Touch system

n SYBR® /FAM

o Scans only channel 1
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o Provides a fast scan

n FRET

o Scans only the FRET channel

o Provides a fast scan

Selecting Fluorophores

Important: Before beginning the run, CFX Maestro software for Mac verifies that the
fluorophores you specified in the plate are calibrated on that instrument. You cannot run a
plate if it includes fluorophores that have not been calibrated on that instrument.

You must load at least one fluorophore to the plate layout before the run. You can add as many
fluorophores as necessary at this time but the plate must contain at least one fluorophore. The
selected fluorophores appear as options for targets in Target Names.

You use the Select Fluorophores dialog box to load fluorophores (or plate dyes) into the Plate
Editor well loading controls. The fluorophores that appear in the Select Fluorophores dialog box
depend on the scan mode you select:

n All Channels

All available fluorophores appear.

Tip: You can add as many fluorophores as necessary, but you can load only one
fluorophore per channel in each well.

n SYBR®/FAM

Only channel 1 fluorophores appear.

n FRET

Only the channel 6 fluorophore appears.

Tip: The channel 6 FRET fluorophore appears only when FRET is the selected scan
mode. It is not available for All Channels scan mode.

Note: You cannot directly add fluorophores to or remove them from the Select Fluorophore
dialog box. You must calibrate new fluorophores on an instrument using the Calibration
Wizard. After calibration, the new fluorophore is automatically added to this list.

144 | CFXMaestro Software for Mac



Creating a Plate File Using the Plate Editor

Selecting Sample Types

Important: You must select at least one sample type to assign to the plate wells before the
run.

CFX Maestro software for Mac offers five sample types:

n Unknown

n Standard

n NTC (no template control)

n Positive Control

n Negative Control

n NRT (no reverse transcriptase)

You assign the sample types to the plate wells.

Setting Up a New Plate

To set up a new plate

1. Open a new plate in the Plate Editor window.

2. To set the plate size, select Settings > Plate Size and select the appropriate plate size from the
dropdown menu.

3. To set the plate type, select Settings > Plate Type and select either BR White or BR Clear from
the dropdown menu.

4. Optionally, from the Settings menu you can change the number convention and the display
units:

n To change the number convention, select Settings > Number Convention and select
Scientific Notation.

Tip: Scientific Notation is selected by default. In this case, selecting Scientific Notation
clears the default and sets the number convention to standard form.

n To change the display units, select Settings > Units and select a new unit value.

5. To set the scan mode, select the appropriate scan mode from the Scan Mode dropdown list in
the Plate Editor window toolbar.
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6. Select the requisite flourophores for the plate:

a. In the right pane, click Select Fluorophores.

The Select Fluorophores dialog box appears. You see the fluorophores available for the
type of scan mode you selected in Step 5, for example:

b. To select a fluorophore, click its Selected checkbox.

Tip: To remove a fluorophore from the list, clear its Selected checkbox.

c. To change the display color of the fluorophore, click its Color box.

Note: The color you select represents the fluorophore in both the Plate Editor window
and the Data Analysis charts.

d. In the Color dialog box, select the color that you want or click Define Custom Colors and
create a new color to represent the fluorophore.

e. Click OK to save the changes and exit the Select Fluorophores dialog box.

7. You must select at least one well in which to load a sample type. By default, well A1 is
selected.

In the plate pane, do one of the following:

n To load multiple adjacent wells, click a well and drag to the target well.

n To load multiple nonadjacent wells, hold the Control key and click each well.
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n To load an entire column with the same sample type, click the column number.

n To load an entire row, click its row number.

n To load the whole plate, click the upper left corner of the plate.

For example:

8. Assign a sample type to the selected well or wells from the Sample Type dropdown menu.

9. Assign at least one fluorophore to all wells that contain a sample type. You can assign more
than one fluorophore to a well or group of wells.

Note: You can assign only one fluorophore per channel. You cannot assign more than
one fluorophore from the same channel to the same well.

Tip: You can associate a target with the fluorophore or you can assign only the
fluorophore to the well at this time and associate a target to the fluorophore after you run
the experiment.
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n To assign only a fluorophore to the selected wells, in the Target Names section in the right
pane select the Load checkbox for the specific fluorophore.

n To associate a target with a fluorophore, in the Target Names section select a target name
from the dropdown list for the specific fluorophore. The software automatically selects its
Load checkbox.

10. For wells containing a Standard sample type, you must load a concentration. Each well can
have a different concentration value. By default, CFX Maestro software for Mac loads a
concentration of 1.00E+06 to all wells with a Standard sample type. You can change the value
if necessary.

a. In the plate pane, select a Standard well or group of wells.

b. In the Concentration section click Load to load the value to the selected well or wells.

c. (Optional) To load another concentration, type the new value in the Concentration text box
and press enter.

d. Perform this step for all wells with sample type Standard.

Tip: To load the same concentration to all Standard wells, ensure that <All> appears
in the dropdown list below the Concentration value. To load the same concentration
value to all wells with a specific fluorophore, click the dropdown list and select the
fluorophore.

11. Click OK to save the new plate.
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Assigning Optional Parameters to the Plate File
A plate file contains information about the contents of each well loaded with sample for a run. After
the run, CFX Maestro software for Mac links the well contents to the fluorescence data collected
during the protocol and applies the appropriate analysis in the Data Analysis window.

In CFX Maestro, you can assign parameters to each well in your plate before, during, or even after
you run experiments. You can assign the parameters to an existing plate file or to a new plate file.
These parameters include:

n Target names— the target or targets of interest (genes or sequences) in each loaded well.

n Sample names— the identifier or condition that corresponds to the sample in each loaded
well, such as mouse1, mouse2, or mouse3.

n Biological groups— the identifier or condition that corresponds to a group of wells, such as
0Hr, 1Hr, or 2Hr.

Tip: Target names, sample names, and biological groups must be the same between
wells to compare data in the Gene Expression tab of the Data Analysis window. Each
name must contain the same capitalization, punctuation, and spacing. For example,
“Actin” is not the same as “actin,” “2Hr” is not the same as “2 hr.,” and “Mouse 1” is not the
same as “mouse1.” To ensure naming consistency, enter the names in the Libraries
section in User > User Preferences > Plate, available on the Home window.

n Technical replicates— each well that is used to analyze the same combination of sample
and target(s); that is, replicate qPCR reactions.

n Dilution series— the amount to change the concentration of the Standard sample type within
a replicate group to create standard curve data to analyze.

Assigning a Target to Wells
Tip: You can assign the same target name to a single or multiple wells. You can also assign
multiple targets to the same well.

Important: Clicking OK after you assign a target saves the changes and disables Undo on the
Plate Editor toolbar. Take care when clicking OK.

To assign a target to a well or group of wells

1. In the Plate Editor, ensure that the well or group of wells have been assigned a sample type.

See Selecting Sample Types on page 145 for information about assigning sample types to
wells.
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2. In the plate pane, select the well or group of wells:

n To select a single well, click the well.

n To select multiple adjacent wells, click a well and drag to the target well.

n To select multiple nonadjacent wells, hold the Control key and click each well.

n To select an entire column with the same sample type, click the column number.

n To select an entire row, click its row number.

3. In the right pane, select a name from the Target Name dropdown list for each selected
fluorophore.

4. Repeat Step 3 for each well or group of wells to which you must assign a target.

Tip: You can assign the same or a different target name for each selected fluorophore.

5. Click OK to accept the changes and save the plate.

Note: If you changed the plate in error, click Undo on the Plate Editor toolbar before you
click OK to accept the changes.

To remove a target name

u To remove a target name from the selected well or group of wells, clear its Load checkbox.

Important: Removing a target name from a well also removes its associated fluorophore. Take
care when removing a target name from a well.

To add a target name to the list

u To add a target name to the dropdown list, do one of the following:

n Type a name in the Target Name dropdown list and press Enter.

Tip: Target names that you add to one list appear in all other target lists.
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n Click the green + symbol to the right of the dropdown list, type a name for the target and
press Enter.

n Click User Preferences on the toolbar and add the name to the Target Names library in
the Plate tab.

Important: Target names that you add in the dropdown list are available only for the
current plate, and only if you assign the name to a well and save the plate layout. If you do
not assign the name to a well and save the plate layout, the name is not saved and is not
available for future use. To permanently add a target name, also add it to the Target
Names library using the User Preferences dialog box. Names that you add to the library
are available after you open the Plate Editor again. See Setting Default Plate Parameters
on page 24 for more information.

To delete a target name from the list

1. Click User Preferences on the toolbar.

The User Preferences dialog box appears, displaying the Plate tab.

2. In the Target Names library in the Plate tab, select the name to delete and press the Delete
key.

3. Click OK to save changes and exit the User Preferences dialog box.

Important: You cannot delete target names that you saved with a plate file. Custom
names that you add to the Target Names dropdown list and do not use and save with the
plate are automatically removed from the list. Names that you delete from the Target
Names Library are permanently removed from the software and are no longer available to
users. Take care when deleting target names.

Assigning a Sample Name to Wells
Note: To assign a sample name, you must assign the selected wells at least one fluorophore.
If the selected wells are not assigned a fluorophore, the Sample Names dropdown list is
disabled. See Assigning a Target to Wells on page 149 for information about assigning
fluorophores.

Tip: You can assign only one sample name to each well or group of wells.

To assign a sample name to a well or group of wells

1. In the Plate Editor, ensure that the well or group of wells has been assigned a fluorophore.

2. In the plate pane, select the well or group of wells.

3. In the right pane, select a name in the Sample Names dropdown list.
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The software automatically selects its Load checkbox.

4. Repeat Step 3 for each well or group of wells to which you must assign a sample name.

5. Click OK to accept the changes and save the plate.

Note: If you changed the plate in error, click Undo on the Plate Editor toolbar before you
click OK to accept the changes.

To remove a sample name

u To remove a sample name from a selected well or group of wells, clear its Load checkbox.

To add a sample name to the list

u To add a sample name to the dropdown list, do one of the following:

n Type a name in the Sample Names dropdown list and press Enter.

n Click the green + symbol to the right of the dropdown list and type a name for the sample.

n Click User Preferences on the toolbar and add the name to the Sample Names library in
the Plate tab.

Important: Sample names that you add in the dropdown list are available only for the
current plate, and only if you assign the name to a well and save the plate layout. If you do
not assign the name to a well and save the plate layout, the name is not saved and is not
available for future use. To permanently add a sample name, also add it to the Sample
Names library using the User Preferences dialog box. Names that you add to the library
are available after you open the Plate Editor again. See Setting Default Plate Parameters
on page 24 for more information.

To delete a sample name from the list

1. Click User Preferences on the toolbar.

The User Preferences dialog box appears, displaying the Plate tab.
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2. In the Sample Names library in the Plate tab, select the name to delete and press the Delete
key.

3. Click OK to save changes and exit the User Preferences dialog box.

Important: You cannot delete sample names that you have saved with a plate file.
Custom names that you add to the Sample Names list and do not use and save with the
plate are automatically removed from the dropdown list. Names that you delete from the
Sample Names Library are removed from the software and are no longer available to
users. Take care when deleting sample names.

Assigning Biological Groups to Wells
Note: To assign a biological group, you must assign the selected wells at least one
fluorophore. Assigning a fluorophore enables the Biological Groups dropdown list. See
Assigning a Target to Wells on page 149 for information about assigning fluorophores.

Tip: You can assign one biological group to each well or group of wells.

To assign a biological group to a well or group of wells

1. In the Plate Editor, ensure that the well or group of wells has been assigned a fluorophore.

2. In the plate pane, select the well or group of wells.

3. In the right pane, select a name in the Biological Group dropdown list.

CFX Maestro software for Mac automatically selects its Load checkbox.

4. Repeat Step 3 for each well or group of wells to which you must assign a biological group.

5. Click OK to accept the changes and save the plate.

Note: If you changed the plate in error, click Undo on the Plate Editor toolbar before you
click OK to accept the changes.

Tip: Assigning biological group names to wells enables Biological Group Analysis
Options in the Experiment Settings dialog box, in which you can perform sample analysis
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in one of four configurations. SeeChanging Experiment Settings on page 160 for more
information.

To remove a biological group

u To remove a biological group from the selected well or group of wells, clear its Load checkbox.

To add a biological group name to the list

u To add a biological group name to the dropdown list, do one of the following:

n Type a name in the Biological Group dropdown box and press Enter.

n Click the green + symbol to the right of the dropdown list and type a name for the
biological group.

n Click User Preferences on the toolbar and add the name to the Biological Names library
in the Plate tab.

Important: Biological group names that you add in the dropdown list are available only
for the current plate, and only if you assign the name to a well and save the plate layout. If
you do not assign the name to a well and save the plate layout, the name is not saved and
is not available for future use. To permanently add a biological group name, also add it to
the Biological Names library using the User Preferences dialog box. Names that you add
to the library are available after you open the Plate Editor again. See Setting Default Plate
Parameters on page 24 for more information.

To delete a biological group name from the list

1. Click User Preferences on the toolbar.

The User Preferences dialog box appears, displaying the Plate tab.

2. In the Biological Names library in the Plate tab, select the name to delete and press the Delete
key.

3. Click OK to save changes and exit the User Preferences dialog box.

Important: You cannot delete biological group names that you saved with a plate file.
Custom names that you add to the Biological Group Names dropdown list and do not use
and save with the plate are automatically removed from the list. Names that you delete
from the Biological Names Library are permanently removed from the software and are no
longer available to users. Take care when deleting biological names.

To view all biological groups on the plate

u Click Show Biological Groups to view all biological groups on the plate.
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Each group is identified by a specific color and the Show Biological Groups button changes to
Hide Biological Groups.

Click Hide Biological Groups to clear the color in the wells. Alternatively, you can click any well
in the plate to hide biological groups.

Assigning Technical Replicate Numbers to Wells
Important: To assign technical replicate numbers, the selected wells must contain identical
well contents. That is, the selected wells must have the same sample type and fluorophore. If
appropriate, they must also be assigned the same target and sample names and the same
biological group. If they are not the same, CFX Maestro software for Mac does not enable this
option.

To assign technical replicate numbers to a group of wells

1. In the Plate Editor, ensure that the contents of the group of wells are identical.

2. In the plate pane, select the target group of wells.

3. To assign the same replicate number to all selected wells, in the Replicate # section in the
right pane type the replicate number in the box and select Load.

4. (Optional) To apply a replicate series to a set of selected wells:

a. Click Technical Replicates. The Replicate # section expands to display the following
options:
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n Replicate size— a number that represents the number of wells in each group of
replicates

n Starting replicate #— the first number in the replicate series for the selected group
of replicates

Note: By default, CFX Maestro software for Mac displays the starting replicate
number as one number greater than the last technical replicate number assigned in
the plate. For example, if the last technical replicate number in the plate is five, the
next starting number is six. You can change the starting number to any number that is
not already assigned.

n Loading direction (Horizontal or Vertical)

b. Click Apply to apply the parameters to the series and return to the Replicate # display.

5. Click OK to accept the changes and save the plate.

Note: If you changed the plate in error, click Undo on the Plate Editor toolbar before you
click OK to accept the changes.

To remove a well from a replicate series

u Select the well or group of wells to be removed and clear the Replicate # Load checkbox.

Alternatively, you can click Clear Replicate # to clear the replicate number from a selected well
or group of wells.

To view all technical replicates on the plate

u Click Show Technical Replicates to view all technical replicates on the plate.

Each group is identified by a specific color and the Show Technical Replicates button changes
to Hide Technical Replicates.

Click Hide Technical Replicates to clear the color in the wells. Alternatively, you can click any
well in the plate to hide technical replicates.
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Assigning a Dilution Series to Standard Sample Types
As previously mentioned, all wells with the sample type Standard must be assigned a
concentration value. You can assign a dilution series to multiple wells with the sample type
Standard.

Note: In order to assign a dilution series to a group of wells, the wells must be included in a
technical replicate series. See Assigning Technical Replicate Numbers to Wells on page 155
for information about adding wells to a replicate series.

To assign a dilution series to a group of Standard sample wells

1. In the Plate Editor, ensure the following requirements are met:

n The sample type for the group of wells is Standard.

n All wells in the group are assigned at least one fluorophore and they all contain the same
fluorophores.

n All wells in the group are included in the same technical replicate series.

Note: CFX Maestro software for Mac enables the Dilution Series option only when all
selected wells meet these criteria.

2. In the plate pane, select the target group of wells.

3. In the Concentration section in the right pane, click Dilution Series. The Concentration section
expands to display the following options:

n Starting concentration— the concentration value from which the series starts

n Replicates from and to— the replicates in the series to which the dilution factor will be
applied

n Dilution factor— the amount to change the concentration within each replicate group

User Guide | 157



Chapter 8 Preparing Plates

4. Set the values for the options or accept the defaults.

5. By default, the dilution series decreases by the dilution factor. Select Increasing to increase
the dilution series.

6. (Optional) By default, the dilution factor applies to all fluorophores in the replicate series. If
your series contains more than one fluorophore and you want to apply the dilution to a single
fluorophore, select it from the dropdown list.

7. Click Apply to apply the dilution series to the group of wells and return to the Concentration
view.

8. Click OK to accept the changes and save the plate.

Note: If you changed the plate in error, click Undo on the Plate Editor toolbar before you
click OK to accept the changes.

Copying Well Contents into Another Well
You can copy the contents of a well and paste it into a single or multiple wells. However, you can
copy the contents of only a single well. You cannot select multiple wells and copy their contents.

To copy well contents into another well

1. In the plate pane, select the well to be copied.

2. Right-click the well and select Copy Well.

3. Select the well or wells into which content is to be pasted:

n To select a single well, click on the well.

n To select multiple adjacent wells, click a well and drag to the target well.

n To select multiple nonadjacent wells, hold the Control key and click each well.

4. With the target wells selected, right-click and select Paste Well.

CFX Maestro software for Mac pastes the contents of the first well into the selected wells.

Adding a Note to a Well
You can add a descriptive note to a well. You can view the well notes in the Quantification tab in
the Data Analysis window.

To add a note to a well

1. In the plate pane, select the well or wells to which you plan to add a note.

2. In the View section in the bottom pane, select Well Note.
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The Well Note dialog box appears in the right pane.

3. Type the content for the note in the textbox and press Enter.

The text appears at the bottom of the selected wells.

Tip: If you created a previous well note, you can select it from the dropdown list and apply
it to the selected wells.

Clearing Wells of All Content
You can clear an individual well, a group of wells, or the whole plate of all content. Clearing wells
does not remove the fluorescence data collected during the plate read.

Clearing a well permanently removes the content from the well. If you click OK and save the plate
after clearing a well, you cannot undo the clear action. Take care when clearing wells.

To clear wells of all settings

1. In the Plate Editor, select the well or group of wells in the plate pane:

n To select a single well, click on the well.

n To select multiple adjacent wells, click a well and drag to the target well.

n To select multiple nonadjacent wells, hold the Control key and click each well.

n To select an entire column with the same sample type, click the column number.

n To select an entire row, click its row number.

2. In the right pane, click Clear Wells.

CFX Maestro software for Mac clears the selected wells of all settings.

3. Do one of the following:

n If you cleared the wells in error, click Undo on the Plate Editor toolbar before you click OK
to accept the changes.

Important: Clicking OK before you click Undo saves the changes and disables Undo
on the Plate Editor toolbar.

n Click OK to accept the changes and save the plate.
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Changing Experiment Settings
Use the Experiment Settings dialog box to view or change the list of targets, samples, or biological
groups, or to set the gene expression analysis sample group to analyze if you assigned biological
groups to wells in the plate.

In the Experiment Settings dialog box, the Targets tab displays a list of target names for each PCR
reaction, such as the target gene or gene sequences of interest.

The Samples and Biological Groups tab displays a list of sample and biological group names that
indicate the source of the target, such as a sample taken at 1 hour (1Hr) or from a specific
individual (mouse1).

To change plate settings using the Experiment Settings dialog box

1. To open the Experiment Settings dialog box, do one of the following:

n In the right pane in the Plate Editor, click Experiment Settings.

n In the Gene Expression tab in the Data Analysis window, click Experiment Settings.

The Experiment Settings dialog box appears displaying the contents of the Targets tab.

2. To add a new target, sample, or biological group name, in the appropriate tab type a name in
the New textbox and click Add.
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3. To remove one or more target, sample, or biological group names from the list, in the
appropriate tab select the item’s checkbox in the Select to Remove column and click Remove
checked item(s).

4. CFX Maestro software for Mac excludes the sample type NTC (no template control) from gene
expression analysis.

To include NTC sample types, clear its checkbox in the Exclude the following sample types
section. You can choose to exclude the following sample types by selecting the appropriate
checkbox:

n NRT (no reverse transcriptase)

n Negative Control

n Positive Control

n Standard

5. In the Targets tab:

a. To select a target as the reference for gene expression data analysis, select it in the
Reference column.

b. To hide analysis settings that will be applied in the Gene Expression tab in the Analysis
Settings window, clear Show Analysis Settings.

The software hides the following columns:

n Color

n Show Chart

n Auto Efficiency

n Efficiency (%)

c. To change the color of the target as it is graphed in the Gene Expression chart, click its
cell in the Color column, select a new color in the Color dialog box that appears, and click
OK.

d. To display the target in the selected color in the Gene Expression chart, select its
checkbox in the Show Graph column.

e. By default, CFX Maestro automatically calculates the relative efficiency for a target if its
data include a standard curve.

To use a previously determined efficiency value, type the value in its cell in the Efficiency
(%) column and press the Enter key. CFX Maestro clears the Auto Efficiency checkbox.
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6. In the Samples and Biological Groups tab:

a. To select a sample or biological group as the control sample for gene expression data
analysis, select its checkbox in the Control column.

b. To assign the control condition to a sample or biological group for a run, click its checkbox
in the Control column.

c. If it is not already selected, click Show Analysis Settings to view or change analysis
parameters that will be applied in the Gene Expression tab. The software hides the Color
and Show Chart columns.

7. Click OK to save the parameters in the Experiment Settings dialog box and return to the Plate
Editor window.

Creating Well Groups
Well groups divide a single plate into subsets of wells that can be analyzed independently in the
Data Analysis window. Once well groups are set up, select one in the Data Analysis window to
analyze the data as an independent group. For example, set up well groups to analyze multiple
experiments run in one plate or to analyze each well group with a different standard curve.

Note: The default well group is All Wells.

To create well groups

1. To open Well Groups Manager, do one of the following:

n In the Plate Editor toolbar, click Well Groups.

n In the Data Analysis window, click Manage Well Groups.

The Well Groups Manager dialog box appears.
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2. Click Add to create a new group. The dropdown menu displays the group name as Group 1 for
the first group.

3. Select the wells for the well group in the plate view by clicking and dragging across the group
of wells. Selected wells appear blue in the Manager.

4. (Optional) To change the name of the group, select its name in the dropdown menu and type a
new name.

5. (Optional) To delete a well group, select its name in the dropdown list and click the Delete.

6. Click OK to finish and close the window, or click Cancel to close the window without making
changes.
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Right-Click Menu Items for the Well Groups Manager Dialog Box

Table 28 lists the menu items available in the Well Groups Manager dialog box when you right-
click on any well.

Item Function

Copy Copies the well contents, which can then be pasted into
another well or wells.

Copy as Image Copies the well selector view as an image.

Print Prints the well selector view.

Print Selection Prints only the selected cells.

Export to Excel Exports the data to an Excel spreadsheet.

Export to Csv Exports the data as a comma-separated document.

Export to Xml Exports the data as an .xml document.

Export to Html Exports the data as an .html document.

Table 28. Right-click menu items in the Plate Editor Well Selector dialog box
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Changing Trace Styles
During plate setup and while a run is in progress, you can modify the color and style of the
amplification traces. You can then easily view the traces in the real-time status window as the data
are being collected.

To change trace styles

1. Click Trace Styles in the Plate Editor toolbar.

The Trace Styles dialog box appears for the open plate, for example:

2. To display the trace styles by a specific fluorophore, select it from the Fluorophores dropdown.

3. To change the trace display:

a. Select the trace type from the Wells dropdown list.

b. Click its color in the Color column.

c. In the Color dialog box that appears, choose another color for the trace and click OK.

The change for the well type appears in the grid below.

d. (Optional) Select a symbol for the trace from the Symbols dropdown list.

4. To quickly change the color set, click the appropriate choice in the Color Quick Set section.

5. To view well labels in the grid, select the label type in the Well Labels section.

6. Click OK to save changes or Cancel to cancel changes.
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Viewing the Plate in Spreadsheet Format
The Spreadsheet View/Importer tool displays the contents of a plate in spreadsheet format. You
can use the Spreadsheet View/Importer tool to export well contents in tab-delimited format to an
application such as Microsoft Excel. You can also import well contents from a tab-delimited
application.

To use the Spreadsheet View/Importer tool

1. On the Plate Editor toolbar, click Spreadsheet View/Importer to open the Plate Spreadsheet
View dialog box.

2. The Spreadsheet View dialog box displays the contents in the plate for a single fluorophore.
To view the plate contents for another fluorophore, select it from the Fluors List dropdown list.

3. Click Export Template to export a template of the plate spreadsheet to an Excel file (.csv
format). You can edit this template to import well content information.

4. (Optional) Click Import to import well contents from a comma-delimited file.

5. To sort the spreadsheet according to the data in a specific column, click the triangle next to a
column name.

Tip: You can edit the contents of any cell in a column that has an asterisk (*) beside the
column name (for example *Target Name).
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Note: Select the units for the standard curve data in the Quantity column by opening the Plate
Editor and selecting Settings > Units in the menu bar. After the plate run is completed, the data
from these standards appear in the Standard Curve chart in the Quantification tab in the Data
Analysis window with the units you select.

Right-Click Menu Items for the Plate Spreadsheet View/Importer Tool

Table 29 lists the menu items available in the Spreadsheet View/Importer tool when you any right-
click on any well in the tool.

Item Function

Copy Copies the entire spreadsheet.

Copy as Image Copies the spreadsheet as an image file.

Print Prints the spreadsheet.

Print Selection Prints only the selected cells.

Export to Excel Exports the file to an Excel spreadsheet.

Export to Text Exports the file as a text file.

Export to Xml Exports the file as an .xml file.

Export to Html Exports the file as an .html file.

Find Searches for specific text.

Sort Sorts the spreadsheet by selecting up to three columns of data in
the Sort window.

Table 29. Right-click menu items in the Plate Spreadsheet View/Importer tool
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Creating a Plate Layout Using the Plate Setup Wizard
You can use the Setup Wizard to enter the plate layout information that is needed for normalized
gene expression analysis, including:

n Target names

n Sample names

n Location of targets and sample on the plate

n Reference gene(s)

n Control sample

You can use the Setup Wizard before, during, or after a run.

Using the Plate Setup Wizard
This section explains how to create a plate layout using the plate Setup Wizard. To view the
contents of each well in the plate more easily, click Zoom plate at the top of the Setup Wizard.

Important: Returning to the Auto layout tab while on any other tab in the Setup Wizard resets
the plate layout. Take care when selecting this tab.

Tip: You can reset the layout by selecting Tools > Clear Plate in the Setup Wizard.

To use the plate Setup Wizard

1. Open the Plate Editor.

2. To open the Setup Wizard, do one of the following:

n Choose Editing Tools > Setup Wizard.

n Click Setup Wizard on the Plate Editor toolbar.

The Setup Wizard appears displaying the Auto layout tab.
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3. In the Auto layout tab, do the following:

a. Click a well in the grid and drag across and down to specify the area on the plate in which
you plan to load sample.

b. Enter the number of targets and samples to load.

Tip: The number of targets and samples must equal the number of selected cells. If
the numbers entered do not fit in the area selected, modify the numbers or plate
selection area. The orientation of items on the plate and their grouping can be
specified.

c. (Optional) Change the plate orientation. For example, you can set targets in columns and
samples in rows, or group by samples.

d. Click Next to proceed to the Target names tab.

Note: If your plate layout does not have a regular pattern, use the Target names tab to
manually position your targets or the Sample names tab to manually position your
samples on the plate. Click and drag to select multiple wells.

4. In the Target names tab, define target names for the target groups:

a. Do one of the following:

n To rename targets by group, set Select by to Target.
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n To rename targets by well, set Select by to Well.

b. Select a target group or well in the grid and type a name in the Target name dropdown
list.

Tip: Press Tab to select the next group or well to the right or Enter to select the next
group or well below. Alternatively, on the Target name and Sample name tabs, hold
the Control key and click a well to select multiple wells that are not adjacent.

c. Click Next to proceed to the Sample names tab.

5. In the Sample names tab, define sample names for the sample groups.

6. Click Next to proceed to the Reference targets tab.

7. In the Reference targets tab, select one or more targets to use as references for normalized
gene expression and click Next to proceed to the Control sample tab.

8. In the Control sample tab, select one sample to use as a control for relative gene expression
calculations.

9. Click OK to save the plate layout and return to the Plate Editor, in which you can further define
plate parameters. See Assigning Optional Parameters to the Plate File on page 149 for more
information.

Alternatively, click Previous to return to a previous tab to make any changes.

Note: Returning to the Auto layout tab automatically resets the plate. Take care when
clicking Previous.
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CFX Maestro™ software calculates formulas automatically and displays the results in the Data
Analysis tabs. This appendix explains in detail how CFX Maestro software calculates formulas.

P-Value
The P-value is a measure of the statistical significance between the differential expression of a
biological group relative to a control group. It is the probability of obtaining the observed (or more
extreme) result, assuming that there is no difference between the two biological groups.

The P-value is calculated using an unpaired t-test that assumes equal variances between the
groups under analysis. For example, a P-value of 0.05 indicates that there is a 5 percent
probability that this or a more extreme result will randomly occur.

Note: At least two samples are required to determine the P-value for both control and
experimental biological groups. The more samples that are present, the greater the accuracy.
Use of the P-value assumes that the log-converted expression values of the samples within
the biological groups are normally distributed. Use the Shapiro-Wilk Normality Test in the
ANOVA tab to assess normality. For more information, see Shapiro-Wilk Normality Test on
page 127.

The following calculation refers to the P-value displayed within the Graphing and Volcano Plot
tabs. For descriptions of the P-values displayed within the ANOVA tab, see Results Table on page
126.

Note: Expression is converted to a log2 scale before the P-value is calculated.

The formula for P-value is

P-value = 1 – A

Where:

User Guide | 171



AppendixAData AnalysisCalculations

Where:

n

n Γ = gamma function

n t = t-statistic

Where:

n Mean = Arithmetic mean

n NE = Normalized expression

n Count(x) = Size of list x

n SD = Sample standard deviation

Differences in P-Value Results
P-value results might differ depending on the chart you are viewing.

Results Tab

The P-values reported on the Results table are the results of unpaired t-tests comparing the
distributions of per well Normalized Expression (NE) values for the control sample versus the test
sample.

Bar Chart Tab

The P-values reported in the bar chart table are based on the control that is selected on the Bar
Chart tab.

ANOVA Tab

The P-Value ANOVA (uncorrected) and P-Value BH (Benjamini-Hochberg correction for testing
multiple targets) that are reported on the ANOVA table are based on the F statistic from ANOVA,
and indicate whether there are statistically significant differences among the means of the
biological groups for each target. The ANOVA table also shows the results of Tukey's HSD test for
each target. The P-Value Tukey indicates the significance of the difference in means for each
pairwise comparison of biological groups for a given target. The P-Value Tukey is corrected for the
family-wise error rate when testing multiple biological groups.
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Shapiro-Wilk Normality Test Tab

The P-value reported in the Shapiro-Wilk test is based on the W-value. In this test, P-value
indicates the probability that the data are obtained from a normally distributed population (null
hypothesis). A significant (small) P-value that rejects the null hypothesis indicates the data are
unlikely to have come from a normal distribution.

Reaction Efficiency
Evidence suggests that using an accurate measure of efficiencies for each primer and probe set
will give you more accurate results when analyzing gene expression data. The default value of
efficiency used in the gene expression calculations is 100%. To evaluate the reaction efficiency,
generate a standard curve using serial dilutions of a representative sample across a relevant
dynamic range and then record the efficiency for subsequent gene expression analysis. If your run
includes a standard curve, then the software automatically calculates the efficiency and displays it
under the Standard Curve on the Quantification tab when Auto Efficiency is checked in the Targets
tab in the Experiment Settings window.

The efficiency (E) in the efficiency formulas refers to the “efficiencies” as described by Pfaffl (2001)
and Vandesompele et al. (2002). In these publications, an efficiency of 2 (perfect doubling with
every cycle) is equivalent to 100% efficiency in this software. You have the option to convert your
efficiency calculations to those used in the software by using the following mathematical
relationships:

n E = (% Efficiency * 0.01) + 1

n % Efficiency = (E – 1) * 100

Relative Quantity
The formula for relative quantity (ΔCq) for any sample (GOI) is:

Note: This formula is used to calculate Relative Quantity when there is no control sample or
biological group defined.

Where:

n E = Efficiency of primer and probe set. This efficiency is calculated with the formula (%
Efficiency * 0.01) + 1, where 100% efficiency = 2

n C q (min) = Average Cq for the Sample with the lowest average Cq for GOI
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n C q (sample) = Average Cq for the Sample

n GOI = Gene of interest (one target)

Relative Quantity When a Control Is Selected
When a control sample or biological group is assigned, then the relative quantity (RQ) for any
sample with a gene of interest (GOI) is calculated with this formula:

Where:

n E = Efficiency of primer and probe set. This efficiency is calculated with the formula (%
Efficiency * 0.01) + 1, where 100% efficiency = 2

n Cq (control) = Average Cq for the control sample, or average Cq Mean for the biological group

n Cq (sample) = Average Cq for any samples with a GOI

n GOI = Gene of interest (one target)

Standard Deviation of Relative Quantity
Important: This calculation is applicable only when Analyze Using is set to Samples Only,
Sample Biological Group, or Biological Group Sample.

The formula for standard deviation of the relative quantity is

Where:

n SD Relative Quantity = standard deviation of the relative quantity

n SD CqGOI sample = Standard deviation of the Cq for the sample (GOI)

n Relative Quantity = Relative quantity of the sample

n E = Efficiency of primer and probe set. This efficiency is calculated with the formula (%
Efficiency * 0.01) + 1, where 100% efficiency = 2

n GOI = Gene of interest (one target)
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Efficiency Corrected Cq (CqE)
The formula for efficiency corrected Cq is

Where:

n E = Efficiency

Mean Efficiency Corrected Cq (MCqE)
The formula for mean efficiency corrected Cq is

Where:

n CqE = Efficiency corrected Cq

n n = Number of replicates

Normalized Expression
Normalized expression (ΔΔCq) is the relative quantity of your target (gene) normalized to the
quantities of the reference targets (genes or sequences) in your biological system. To select
reference targets, open the Experiment Settings window and click the reference column for each
target that serves as a reference gene.

The formula for normalized expression, which uses the calculated Relative Quantity (RQ)
calculation, is

Where:

n RQ = Relative quantity of a sample

n Ref = Reference target in a run that includes one or more reference targets in each sample

n GOI = Gene of interest (one target)

Provided that reference targets do not change their expression level in your biological system, the
calculation of normalized expression will account for loading differences or variations in cell
number that are represented in each of your samples.
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Expression and Relative Quantity for Biological Groups
When Analyze Using is set to Biological Groups Only, the software displays the average
expression (normalized expression or relative quantity, depending on mode selection) of the
samples within the biological group. Because expression is typically log-normally distributed, the
expression is averaged using the geometric mean:

Where:

n Exp1, Exp2, Expn = Relative quantity or normalized expression of the samples in the biological
group

n n = Number of samples in the biological group

Normalized Expression When a Control Is Selected
When you select a control sample in the Experiment Settings window, the software sets the
expression level of the control sample to 1. In this situation, the software normalizes the relative
quantities of all target (gene) expression to the control quantity (a value of 1). This normalized
expression is equivalent to the unscaled normalized expression analysis when a control is chosen.

Note: This is also known as relative normalized expression (RNE) and fold change.

Standard Deviation for the Normalized Expression
Rescaling the normalized expression value is accomplished by dividing the standard deviation of
the normalized expression by the normalized expression value for the highest or lowest individual
expression levels, depending on the scaling option you choose. The formula for standard deviation
(SD) of the normalization factor is

Where:

n RQ = Relative quantity of a sample

n SD = Standard deviation

n NF = Normalization factor

n Ref = Reference target
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n n = Number of reference targets

When a control sample is assigned, you do not need to perform this rescaling function on the
standard deviation, as shown in the following formula:

Where:

n NE = Normalized expression

n RQ = Relative quantity of a sample

n SD = Standard deviation

n GOI = Gene of interest (one target)

Normalized Expression Scaled to Highest Expression Level
When the run does not include controls, scale the normalized expression (NE) for each target
(gene) by dividing the expression level of each sample by the highest level of expression in all the
samples. The software sets the highest level of expression to a value of 1 and rescales all the
sample expression levels. The formula for highest scaling is

Where:

n GOI = Gene of interest (target)

Normalized Expression Scaled to Lowest Expression Level
When the run does not include controls, scale the normalized expression (NE) for each target
(gene) by dividing the expression level of each sample by the lowest level of expression in all the
samples. The software sets the lowest level of expression to a value of 1 and rescales all the
sample expression levels. The formula for lowest scaling is

Where:

n GOI = Gene of interest (target)
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Normalized Expression Scaled to Average Expression Level
When the run does not include controls, scale the normalized expression (NE) for each target
(gene) by dividing the expression level of each sample by the geometric mean level of expression
of all the samples. The software sets the average level of expression to a value of 1 and rescales
all the sample expression levels. The formula for average scaling is

Where:

n GOI = Gene of interest (target)

n GM = Geometric mean of normalized expression for all samples
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Standard Deviation for the Scaled Normalized Expression
Rescaling the scaled normalized expression (NE) value is accomplished by dividing the standard
deviation (SD) of the normalized expression by the normalized expression value for the highest
(MAX) or lowest (MIN) expression level, depending on which scaling option you choose.

Note:When a control sample is assigned, you do not need to perform this rescaling function
on the standard deviation.

The calculation for this formula is

Where:

n NE = Normalized expression

n SD = Standard deviation

n GOI = Gene of interest (target)

n MAX = Highest expression level

n MIN = Lowest expression level
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Error Bars for Standard Deviation(lg) and Standard Error of
the Mean (lg)

In addition to the use of confidence intervals, error bars may be displayed for biological groups
based on the standard deviation or standard error of the mean of the log2 of the expression. The
error bars are calculated as follows:

RQ Lower Error Bar = 2RQ(lg)-SD RQ(lg) or 2RQ(lg)-SEM RQ(lg)

RQ Upper Error Bar = 2RQ(lg)+SD RQ(lg) or 2RQ(lg)+SEM RQ(lg)

Where:

n RQ(lg) = log2 of the relative quantity for the biological group

n SD RQ(lg) = standard deviation of the relative quantity (log2)

n SEM RQ(lg) = standard error of the mean of the relative quantity (log2)

Exp. Lower Error Bar = 2Exp.(lg)-SD Exp.(lg) or 2Exp.(lg)-SEM Exp.(lg)

Exp. Upper Error Bar = 2Exp.(lg)+SD Exp.(lg) or 2Exp.(lg)+SEM Exp.(lg)

Where:

n Exp.(lg) = log2 of the expression (normalized expression) for the biological group

n SD RQ(lg) = standard deviation of the expression (log2)

n SEM RQ(lg) = standard error of the mean of the expression (log2)
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Fold Change

Fold Change
Fold change is a measure of the increase or decrease in the expression of a target for an
experimental versus a control sample or biological group and is determined as follows:

If Expression (experimental) > Expression (control):

If Expression (experimental) < Expression (control):

Note: For Graphing, the Expression is based on either the relative quantity or normalized
expression, depending on the selected mode (see Graphing on page 101). However, for the
Scatter Plot, Clustergram, and Heat Map, fold change is always calculated from the
normalized expression.
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Corrected Values Formulas
Important: These calculations are applicable only when Analyze Using is set to Samples
Only, Sample Biological Group, or Biological Group Sample.

A difference between corrected values and non-corrected values is seen only if a standard curve is
created as part of the real-time PCR run. The software uses three equations to determine the error
propagation:

n Standard Error

n Standard Error for Normalized Expression

n Standard Error for the Normalized Gene of Interest (target)

The formula for standard error is

Where:

n n = Number of reference targets (genes)

n SD = Standard deviation

The standard error for the normalization factor in the normalized expression formula is

Where:

n n = Number of reference targets

n SE = Standard error

n NF = Normalized expression

n RQ = Relative quantity

The standard error for normalized gene of interest (GOI) formula is

Where:

n SE = Standard error

n GOI = Gene of interest (one target)
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Confidence IntervalCalculation for BiologicalGroup Analysis

n NF = Normalization factor

n n = Number of reference targets

Confidence Interval Calculation for Biological Group
Analysis

When conducting biological groups analysis (Analyze Using is set to Biological Groups Only), the
confidence intervals are calculated for relative quantity and relative normalized expression.

The confidence intervals are calculated in log-scale based on t-distribution using the following
formula:

Where:

n = Mean expression of the log-scale expression levels of the samples in the biological group

n SD = standard deviation of the log-scale expression levels of the samples in the biological
group

n n = number of the samples in the biological group

n t = obtained from the t-distribution based on the degrees of freedom and the alpha level

Note: The alpha level can be set using the P-value threshold field in the Graphing tab.

After the confidence intervals are calculated, they are converted to linear scale and presented in
the Gene Expression Data Table and the bar chart in the Graphing tab.

Box and Whisker Chart Calculations
The Box and Whisker chart displays the distribution of the expression values within a biological
group by plotting the data as quartiles. The 1st and 3rd quartiles are represented by the lower and
upper bounds of the box, respectively. The median is displayed as a solid line across the box. The
whiskers represent the minimum and maximum non-outlier values in the data set. Outliers are
values that exceed the 1st and 3rd quartiles by 1.5 times the inter-quartile range.

Note: If there is only one sample in the biological group it is shown as a single circle,
indicating a single data point.

The following Box and Whisker chart demonstrates how these data is represented.

User Guide | 183



AppendixAData AnalysisCalculations

1. Outlier. This outlier's value is > Q3 + (1.5 x [Q3 - Q1]).

Note: Place the cursor over the circle to view a tooltip that displays the sample name and
the relative quantity or normalized expression information depending on which mode is
selected.

2. Maximum non-outlier demarcation

3. Upper/3rd quartile (Q3). 75% of the expression values are less than Q3.

4. Median, or middle-most value, of the rank-ordered expression values

5. Lower/1st quartile (Q1). 25% of the expression values are less than Q1.

6. Minimum non-outlier demarcation

7. Outlier. This outlier's value is < Q1 - (1.5 x [Q3 - Q1]).

LEGEND
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Minpack Copyright Notice (1999) University of Chicago. All rights reserved

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions,
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions, and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following
acknowledgment:

“This product includes software developed by the University of Chicago, as Operator of Argonne
National Laboratory.”
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